
 

 
 
 

Using TI-NspireTM in Your 
Classroom Physics 

 
 
 

©  2009 Texas Instruments Incorporated 
Materials for Institute Participant 

 
This material is for the personal use of T3 instructors in delivering a T3 institute. T3 instructors are further granted limited 
permission to copy the participant packet in seminar quantities solely for use in delivering seminars for which the T3 Office 
certifies the Instructor to present. T3 Institute organizers are granted permission to copy the participant packet for 
distribution to those who attend the T3 institute. Request for permission to further duplicate or distribute this material must 
be submitted in writing to the T3 Office. 

This material is for the personal use of participants during the institute. Participants are granted limited permission to copy 
handouts in regular classroom quantities for use with students in participants’ regular classes and in presentations and/or 
conferences conducted by participant inside his/her own district institutions. Request for permission to further duplicate or 
distribute this material must be submitted in writing to the T3 Office. 

Texas Instruments makes no warranty, either expressed or implied, including but not limited to any implied warranties of 
merchantability and fitness for a particular purpose, regarding any programs or book materials and makes such materials 
available solely on an “as-is” basis. 
 
In no event shall Texas Instruments be liable to anyone for special, collateral, incidental, or consequential damages in 
connection with or arising out of the purchase or use of these materials, and the sole and exclusive liability of Texas 
Instruments, regardless of the form of action, shall not exceed the purchase price of this calculator. Moreover, Texas 
Instruments shall not be liable for any claim of any kind whatsoever against the use of these materials by any other party. 
 
Mac is a registered trademark of Apple Computer, Inc. 
Windows is a registered trademark of Microsoft Corporation. 
T3·Teachers Teaching with Technology, Calculator-Based Laboratory, CBL 2, Calculator-Based Ranger, CBR, TI-GRAPH 
LINK, TI Connect, TI Navigator, TI Nspire, TI SmartView Emulator, TI-Presenter, and ViewScreen are trademarks of 
Texas Instruments Incorporated. 
 
 



 

©2009 Texas Instruments Incorporated  education.ti.com/activities 

This page was intentionally left blank. 



 Table of Contents 
 

Day 1 

1. Introductions/Agenda/Review – Review technology components of Getting Started 

2. Exploring Motion with the CBR 2 – Data Collection 

3. Roller Coaster Energy – A/C/R Model, Simulation 

4. Ohm’s Law – A/C/R Simulation with Data Capture 

5. Light at a Distance – Scratch Data Collection Document on Theme 

6. Law of Gravity: A/C/R Simulation on Theme 

7. Coulomb’s Law 

Day 2 

1. Debrief Day 1; Finish Coulomb’s Law 

2. Document Fan Out – Process to Send Out TNS Files for the Day 

3. CAS & DCC – More Features 

4. Rates of Cooling 
5. Let’s Roll – Ball on Ramp 

6. Projectile Motion  

7. Introduction to Carousel  

Day 3 

1. Debrief Day 2 

2. Transfer Files  

3. Jump Analysis 

4. Forces on an Incline 

5. Friction 

6. Carousel Work 

7. Carousel Presentations 

8. Wrap-Up & Closure 
 

3

cgardner
Sticky Note
incorrect footer



 

©2009 Texas Instruments Incorporated  education.ti.com/activities 

This page was intentionally left blank. 

4



1

The TI-Nspire 
Classroom

Reasoning about algebraic concepts
If the value of x is increased by 5, which expression has a 
value that must also increase by 5?

A. x + 7
B. 4x
C. 8 – x
D. x/2

(New Hampshire 2006, 45% correct)
If ab + ac =0 and a≠0, then which statement must be true?

A.  b = 0
B. c = 0
C. b = c
D. b = -c

(New Hampshire, 2006, 39% correct)

Exponential growth/decay

Which equation describes the relationship
between x and y
16%   A. y = 0.5x

15%   B. y = 1/2x

18%   C. y = 2-x

46%   D.  All of the equations shown 
describe the relationship between x and y.

(Maine 2006,  46%  correct, memorization)

0.252
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TI Nspire: A Possible Solution

• Use technology to provide different learning experiences 
that allow students to interact with the mathematics in 
new ways. 

• Structure lessons that take account of well documented 
trouble spots.

• Ask questions that reveal student thinking - questions 
that promote reasoning and sense making.

The Challenge:

For many students ideas may “stick” for the moment but 
do not stay or transfer to new situations

Research suggests
Students learn if
• they are actively involved in choosing and evaluating 

strategies, considering assumptions, and receiving 
feedback. 

• they encounter contrasting cases- notice new features 
and identify important ones.

• Struggle with a concept before they are given a lecture
• Develop both conceptual understandings and 

procedural skills

• NCTM High School Focal Points suggest reasoning and 
sense making should be the central focus of high school 
math

National Research Council, 1999

Strengthening the practice of formative 
assessment produces significant learning gains
(Black & Wiliam, 1998)

“…when teachers learn to see and hear students’
work during a lesson and to use that 
information to shape their instruction, 
instruction becomes clearer more focused and 
more effective.”

NRC, 2001, p 350
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The questions

• “…the only point of asking questions is to raise issues 
about which a teacher needs information or about 
which students need to think.”

• The responses a task might generate and the ways of 
following up have to be anticipated

• Questions are a significant part of teaching where attention 
is paid to how they are constructed, used to explore, then 
develop learning

(Black et al, 2004)

A “TI-Nspired” Teacher 

• Asking Questions
• Facilitating Discussion
• Asking Questions
• Assessing Student Understanding
• Asking Questions
• Shaping Instruction Based on What 

Students are Thinking

A “TI-Nspired” Student 

• Engaging in Inquiry
• Making Conjectures
• Building Sense-Making

What is the math/science?
Why does is work?

A “TI-Nspired” Classroom 

• Promote classroom discourse.
• Often, teachers ask a short question, one 

student gives a short answer, and then the 
teacher moves on.

• Probe deeper:
• Ask “Why?”
• Ask for students to reason things out.
• Have students comment on other students’

comments.

11 | TI Strictly Private

Pedagogical Foundation:

Students learn mathematics by 
• taking mathematical actions on 

mathematical objects,
• observing the mathematical consequences, 

and 
• reflecting on their meanings.  

Dick, 2007

12 | TI Strictly Private

Types of Activities:

• Action/Consequence/Reflection
• Investigative Activities
• Simple “how to” lessons

• Focus on asking questions that generate 
reasoning and sense making about the 
mathematics

6
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TI-Nspire Activities 

• Address key math/science concepts
• Questions to ask 
• We will consider

• Planning - alignments within courses
• The Student perspective
• The Teacher perspective
• Formative assessment opportunities
• Extensions and further inquiries
• Impact on understanding

• And discuss how the activities might play out 
in your classroom

Goals of the Workshop:

• Become comfortable using the TI-Nspire handheld and TI-
Nspire Computer Software – Teacher Edition

• Recognize that TI-Nspire provides opportunities for 
students to engage in reason and sense making, and 
making connections

• Recognize the implications of having students create and 
use their own documents, along with the value of 
exploration and investigation using pre-made documents

• Recognize that when students struggle with fundamental 
concepts TI-Nspire activities can help provide scaffolding 
and develop understanding

Reasoning/Sense Making Questions

• Compare and contrast: How are they alike? How different?
• Predict forward: “What would happen if . . ?”
• Predict backward: “How can I make…happen?” “Is it possible...?”
• Analyze a connection/relationship: 

“When will...be (larger, equal to, exactly twice, …) compared to ...?”
“When will…be as big as possible?”

• Generalize/make conjectures: 
“When does...work?” “Under what conditions does…behave this way?”
“Describe how to find…” “Is this always true?”

• Justify/prove:  “Why does…work?”
• Consider assumptions inherent in the problem and what would 

happen if they were changed
• Interpret information, make/justify conclusions: 

“The data support…” “This…will make…happen because…”

Burrill & Dick, 2008

Core Belief for TI-Nspire

Educators who appropriately and effectively integrate 
TI-Nspire into their activities and lessons with peers 
and students will enhance both the teaching and 
learning of mathematics and science, leading to 
increased student achievement.  

Your active participation in this institute will provide 
you with content insights, questioning strategies, and 
technology skills to support your success with TI-
Nspire.
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Introduction to 
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Control

More 
Math

Math 
Palette

Alpha keys

Unit Conversion
Important / Keys

/Z or /d for Undo

/Y�or gd for Redo
Repeat for multiple levels of Undo and Redo 

/C�for Copy [once you highlight what you want to copy]

/X�for Cut  [once you highlight what you want to cut] 

/V�for Paste [once you have copied to the clipboard] 

/S�for Save or Save As

/D�to launch the Data Collection APP

Press the / followed by the letter or command.

Let’s get 
started!started!
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Checking TI-Nspire OS  
 
Press c Home 8 System Info 

    
Home    System Info    About 

 
System Info opens a menu that enables you to view and change document and system settings. 
You can also view detailed information about your handheld and its battery status. 
 
Viewing handheld details on the About screen 
The About screen displays information about the TI-Nspire™ handheld type, the operating 
system (OS) version, and product ID. 
For information regarding OS updates, see the chapter Transferring Files in the electronic 
version of the handheld guidebook. This guidebook is available on the Texas Instruments web 
site: http://education.ti.com/guides. 
 
Using Connect-to-Class to Update the Handheld OS 
 
Note: Connect-to-Class can be configured to either manually or automatically check for updates 
to the software and handhelds. See the Connect-to-Class Reference book or the Help menu. 
 
Connect the handheld to the computer via the USB cable. You may connect multiple handhelds 
at one time using the provided USB hub. 
 

  
 
Click on the menu option Tools then Transfer Tool. In the dialog box indicate the type of device 
and click on Add File. Browse to find the new handheld OS file. Click Start Transfer to begin.  

11
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The Transfer Tool

Connect-to-Class™ software includes a Transfer Tool that you can use to 
transfer files to TI-Nspire™ handhelds when a class session is not active. 
The Transfer Tool allows you to transfer document files and operating 
system (OS) files to a succession of handhelds, without requiring students 
to log in. 

The Transfer Tool streamlines the file transfer process. You can select 
TI-Nspire™ document and OS files that you have stored on your 
computer and install them on your students’ TI-Nspire™ handhelds. Once 
the transfer begins, it continues until you stop it. TI-Nspire™ handhelds 
can be connected in succession and receive queued files. Connect-to-
Class™ software keeps track of what handhelds have been connected 
and the status of file transfers to those handhelds.

If you are sending the same files to your entire class, sending files to 
devices when students are not present, or if you do not plan on collecting 
documents using Connect-to-Class™, then you should use the Transfer 
Tool. Transfer Tool does not require a student’s login to send files to the 
handheld; it simply sends the files to connected devices, allowing you to 
send files with or without students present. The Transfer Tool also allows 
you to clear folders and files on the handheld, as well as transfer 
TI-Nspire™ OS files.

This section covers the information you need to know to use the Transfer 
tool.

Opening the Transfer Tool
You can open the Transfer Tool from the Connect-to-Class™ software 
home screen.

To open the Transfer Tool
1. If you have a class session running, end it. 

2. Select Tools > Transfer Tool.

The Transfer Tool dialog displays.

13
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3. Select the Device type from the drop down menu.

Adding files to the transfer list
You must add TI-Nspire™ document files and operating system files (OS) 
to the transfer list in order to transfer them. 

Only one OS per device type may be added to the list. The OS must be a 
newer version than the one currently on your handheld. You cannot 
transfer a version of the OS that is already on the handheld, or an older 
version of the OS.

Adding files to the transfer list
1. If you have not already done so, select the Device type from the drop 

down menu.

2. Click the Add File button.

3. The Open window displays. 

14
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4. Navigate to the file you want to add, and click to select it.

Note: To select multiple files, press and hold the Ctrl key while 
clicking each file name.

5. Click Open. The file(s) are added to the list on the Transfer Tool 
screen.

6. Repeat Steps 2 -5 until all files for transfer are added to the list.

7. Click Start Transfer to send the files.

15
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Removing files from the transfer list
If there are TI-Nspire™ documents or OS files in the transfer list that you 
no longer want to have available for transfer, you can remove the files 
from the transfer list.

1. Click the name of the file you want to remove from the transfer list.

2. Click Remove File.

16
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Changing the destination folder
To change the destination folder for the file transfer, double click in the 
cell and type a new name for the destination folder. Files that you 
transfer will be stored in this folder on student handhelds.

If the destination folder name you designate does not exist on student 
handhelds, the software creates it. 

Note: Folder names may use alphanumeric characters. Special characters 
(? / | : * " " < > | ) are not allowed.

Viewing transfer status
To view the status of individual file transfer for a selected handheld, click 
on the + before the file name to expand the display.

In the expanded view, the following information displays for each 
connected handheld:

• DeviceID (and device icon).

• Name of file

• Progress bar for that file on that handheld.

• Error conditions:

– Low battery

– Wrong device type

– Memory full

– Lost connectivity

Other transfer status information
• When a new device is connected, the status updates.

• The device progress of a file disappears when it reaches 100%.

• Incomplete device transfers remain in the expanded view of the file 
status.

• During a transfer session, the transfer tool keeps track of what 
device IDs have connected and successfully completed one or more 
transfers.

• If a device unplugs and then replugs into the transfer session, the 
transfer tool shows the status of completed transfers, and resumes 
transfer of other files, if necessary.

• During a transfer, if you select the Setup tab, all the controls are 
disabled (read only).

17
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If you stop a transfer
• Files under the Setup tab remain listed. 

• Status information for the transfer no longer displays under the 
Status tab. The message “No transfers are active. Use the Setup tab 
to configure and start the transfer” displays. 

Deleting device folders and files before 
transferring files
The Transfer Tool provides the option to delete all files and folders on 
each connected handheld before beginning a new file transfer. This 
allows you to "baseline" your students’ handhelds to make sure that 
your students’ handhelds contain only the files you want them to use. By 
default, this option is not selected.

You will find this option useful whenever your student’s handheld should 
be blank. Here are some times when you might want to delete folders:

• At the end of a semester, grading period, or conclusion of any 
Instruction module

• Before administering exams

To delete folders and files on connected handhelds
1. Click the check box next to the option.

2. Click the Start Transfer button to begin the deletion.

A message displays to confirm that you want to delete the folders 
and files.

18
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3. Click Yes to confirm.

The status tab tracks the progress of the delete actions as they occur, 
displaying which devices have been plugged in, and when the 
actions are completed. 

Stopping file transfers
You can stop a file transfer at any time.

To stop a file transfer
1. Press the Stop Transfer button.

2. A warning dialog displays, asking if you are sure you want to stop 
the transfer.

3. To confirm that you want to halt transmission, click Yes. Transfers 
are stopped. 

Note: If any student devices received the file or files, those files 
remain on the devices.

Closing the Transfer tool
When you finish transferring files to your students’ TI-Nspire™ 
handhelds, close the Transfer tool. To do this, click Close.
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Exploring Motion with the CBR 2 
Physics – Student Activity 

Name __________________________ 

Class __________________________ 
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Activity Overview: 
• In this investigation you will explore motion over time from two different points of view. In 

the first instance, you will be shown a graph of some motion that has occurred, and your 
job will be to describe a motion sequence that could be represented by the given graph. In 
the second part of the investigation, you will be given a script that describes some motion, 
and then you will produce a sketch that you think would be the result of the described 
motion. In both cases you will verify your answers using the CBR 2 and your TI-Nspire 
CAS handheld. All motion will be in the x or y direction—that is, motion in one dimension. 

• At the end of this investigation you will be able to assess your learning and understanding. 
 
Materials: 
• TI-NspireTM CAS handheld 
• CBR 2 with appropriate cables and a few clamps (one per team) 
• Various objects and ramps to help in making the required motion 
• Exploring_Motion_with_the_CBR_2_Physics.tns 

 

 

How to Use the CBR 2 with the TI-Nspire Data Collection Application (Optional) 

Your teacher will demonstrate how to use the CBR 2 with your TI-Nspire handheld and its Data 
Collection application. 

Some skills you will need are: 

- Create a new document on the TI-Nspire 

- Find and open a document on your handheld 

- Save a document, give it a name, and create or find a folder 

- Launch the Data Collection application 

- Adjust the settings from the Data Collection application menu 

- Add a new application to your problem 

- Adjust the window in Graphs & Geometry 

- Use the Segment tool in Graphs & Geometry 

- Add a new problem to your document 

- Hide and show the function edit line in Graphs & Geometry 

- Start and stop data collection 

- Send and receive files from your TI-Nspire 
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Part 1 – Given a Distance vs. Time Graph, Write a Script to Describe the Motion 

In this part your team will be given seven graphs of distance vs. time data. Your job will be to 
write a script that, when followed, will produce the same graph. 

1. Open a new document on your TI-Nspire handheld and 
select Notes as the first page. On this page, write in 
the assignment name, date, team name, names of the 
team members, and other relevant information, 
including that this is Part 1. 

 
2. Add another Notes page and write your script for the 

motion shown in the image to the right for Graph I. 

 
3. Now add a Graphs & Geometry page and plug the 

CBR 2 into the TI-Nspire handheld. Cancel the pop-up 
screen by pressing e until the Cancel option is 
highlighted and then pressing ·. 

 

4. Now launch the Data Collection application again by 
pressing by pressing / D. 
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5. Set up the data collection as needed for the above graph and your script. Press b to 
explore the options when your focus is on the Data Collection application. Use / e to 
change the focus from Graphs & Geometry to Data Collection. Finally, we want to have the 
data that you collect displayed on the current Graphs & Geometry application. To do this, 
change the focus to the Data Collection application and Select MENU > Experiment > 
Display Data In > App(s) on Current Page. 

6. After doing this, you will see the function entry line on Graphs & Geometry. To hide this, you 
will need to switch applications (/e) and then use /G to hide it. This is a toggle, so 
you may bring the function entry line back with the same keystrokes. 

7. Examine Graph I and determine the time and distance 
settings you think you will need. Set up the window as 
you want it from the Graphs & Geometry menu by 
selecting MENU > Window > Window Settings and 
then adjusting the values. Use e to move to different 
lines, and then highlight OK and press ·. You may 
also adjust the window settings from the Graphs & 
Geometry screen by clicking on the numbers at the 
ends of the axes. 

 

8. At this time, you need to draw the line segments that 
represent the graph that you were given. This is what 
you will do in part 2 of the investigation. To draw, 
select the Segment tool from the Points & Lines menu. 
(Select MENU > Points & Lines > Segment when 
your focus is on Graphs & Geometry.) Then, move to 
the location you want to start drawing and press x to 
start a segment and then again to end the segment. 
This is an option, unless your teacher requires it. 

 

9. Once all the settings are made on the TI-Nspire and 
your team has arranged the CBR 2 and the moving 
object(s), you should collect the data. Switch to the 
Data Collection application (/ e) and then with 
the play button highlighted, press ·. The data 
collection will occur for the time interval you selected, 
and the data will appear as a scatter plot on the 
Graphs & Geometry screen.  

10. If the plot of the data is close to the given graph, then you may move on. If you are off or 
mess up the motion for some reason, you should repeat and discard the first data set. 

11. You might want to add a Notes page after the data collection is successful where you can 
reflect on success or failure. 
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12. When satisfied, add a new problem and continue 
through the other six graphs, saving the document 
periodically using / S. Note: The first time you 
save, you will need to give the document a name and 
place it in the correct folder. 

 

13. Repeat the steps above for the following graphs:  

Graph II 

 

Graph III 

 

Graph IV 

 

Graph V 

 

*Notice that the time of the experiment in the next two 
graphs is different. Adjust the time of the experiment and 
the G&G window as needed. From the Data Collection 
application, select MENU > Experiment > Set Up 
Collection > Time Graph. Enter the values that your team 
thinks best to help match the graphs. Use e to switch 
between the data entry boxes and the OK button. 

 

Graph VI 

 

Graph VII 

 

14. When you have finished all seven graphs, save the document and then send it to each 
person in the team and to your teacher. 
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Part 2 – Given a Script for Motion, Make a Sketch of the Resulting Distance vs. Time 

In this part of the investigation, you will be given seven scripts for motion over time. Your team 
will create a sketch of the distance vs. time plot that you think will occur and then verify using 
the CBR 2. 

1. Open a new document and add a Notes page. On this page, write in the assignment name, 
date, team name, names of the team members, and other relevant information, including 
that this is Part 2. 

2. You may want to write the script again in a Notes page on the TI-Nspire to avoid confusion. 

Script I: Move toward the CBR 2. 

 

3. Add a Graphs & Geometry page, launch the Data Collection application, and set up the data 
collection as you did in Part 1. In this part, there should be more consideration of the time 
needed to do the motion, so you will probably want to adjust the time graph from 5 seconds. 
Make sure you have the data that you collect displayed on the current Graphs & Geometry 
application. To do this, select MENU > App(s) on Current Page. 

4. After you have all of the settings made for the Data 
Collection application, switch to the Graphs & 
Geometry application and adjust the window. Consider 
the maximum distance, since most motion should 
occur within 6 meters of the CBR 2. Then, as the last 
thing you should do before collecting the data, draw 
what they think will happen with the distance vs. time 
plot as a result of the described motion in front of the   
CBR 2. Use the Segment tool from the Points & Lines menu or other options in Graphs & 
Geometry application, including function graphing, to draw your sketch. 

5. Switch to the Data Collection application, arrange the 
moving object(s), and then collect the data. 
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6. If your attempt is far outside the window setting, you may lose part of your sketch due to the 
Zoom-Stat that occurred after the data collection. Adjust the window in again if you think 
you were close, but if you know it was a bad run, just collect the data again, discarding the 
last set of data. 

7. You might want to add a Notes page after the data collection, where you may reflect on 
success or failures. 

8. When satisfied, add a new problem and continue through the other six scripts. Save the 
document periodically using / S. 

Script II: Move back and forth in front of the CBR 2. 

Script III: Drop an object on the CBR 2. 

Script IV: Stand half the distance away from the CBR 2 and then jump toward it. 

Script V: Point the CBR 2 at an open doorway and then shut the door. 

Script VI: Roll a ball up a ramp, toward the CBR 2. 

Script VII: Rush away from the CBR 2. 

9. When finished, save and then send the document to each person in your group and to your 
teacher. 

Part 3 – The Assessment 

1. Collect the Exploring_Motion_with_the_CBR_2_Physics.tns file from your teacher. Work on 
this as an individual or as a team as per your teacher’s instructions. 

2. As you move from page to page using / ¢, you will 
see a section to enter your answers. In the case of a 
multiple guess or true/false, you will just move to your 
answer and press · to pick. Use / e to switch 
from the top screen to the bottom. When you are 
finished, use / £ to see how well you did. The circle 
means you have not answered the question or it was 
an open response; the check or x indicates you got it 
right or wrong, respectively. 

 

3. Discuss your answers and the experience of this investigation with your team and the class, 
as guided by the teacher. Save and send the assessment to your teacher. 

Extensions – Creating Your Own (Optional) 

1. As a team, create a sketch of some motion over time and then describe how it could occur 
in a script. Swap your sketches with another team and write a script to describe their motion. 
Then regroup with the other team and compare scripts. 

2. Repeat the process above with another team. This time, start with a script. Make your 
solution sketch and then swap scripts. After you get your solutions to the other team’s script, 
compare sketches. 
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Activity Overview: Exploring Motion with the CBR 2 
As students prepare to learn about motion as a function of time in your class, they come to the 
table with certain prior knowledge. In some cases, what they know about motion in one 
dimension is true, and in some cases what they know is not true. In this investigation we will 
establish understandings about motion that will serve as a canvas for teaching mechanics in 
your course. 
 
 
 
 

Teacher Preparation and Notes: 
• This investigation can be done easily in one period if the students have been introduced 

to both the TI-Nspire and the CBR 2. If this is their first experience, you would need most 
of two class periods or one Block class to fully complete this investigation. You may not 
want to do all seven graphs and all seven scripts in parts 1 and 2. You could assign 
different graphs/scripts to different groups to get full coverage, use one of each as a 
demonstration to the class before they start, or just pick some to be done and use the 
others for later assessments or not at all. You may want to cut out some of the steps and 
make the investigation less complicated. If your students are comfortable with CBR 2 
data collection with the TI-Nspire and the Data Collection application, you can take some 
shortcuts and make this investigation involve more inquiry and be less directed. 

• As you prepare for this event, you will need to make sure you have the appropriate 
cables for your CBR 2s and that the CBR 2s are working, with relatively strong batteries. 
Also, you should collect various materials and objects that the teams might want to use 
to produce/reproduce the required motion. Be subtle about this, so as to avoid 
contaminating the groups with your ideas on how to make the motion. 

• Students may need an overview of the Data Collection application and the CBR 2. It is 
assumed the students can move around in a TI-Nspire document. This may be the first 
time that they add a new problem to a document. 

• You will need to demonstrate data collection with the TI-Nspire by using the TI-Nspire 
software. It is best to use the Teacher Edition in the SmartView/Emulator mode so 
students can see which keys you press. Using the CBR 2 with the computer requires the 
USB mini-A to standard-A adapter or a printer cable (USB type A, male to USB type B, 
male). You will want to use teams of 2 or 3 as you do this investigation. 

• Your groups will need some space to do their movements, but all motion will usually 
occur within 4 meters of the CBR 2. The problem is the width of the signal sent from the 
CBR 2. You must make sure that other objects (metals are a particular problem) just off 
line of the moving object do not reflect the signal. The students will figure this out rather 
rapidly, in most cases, but it would useful if you checked on them to make sure they are 
successful on the first graph they try. After that, they will do well on their own. Another 
issue is that teams may want to describe all of the motion at once and then verify. It 
turns out that if they are wrong, all the attempts will be wrong, so they will have to redo. 
If you consider this a constructivist event, it will be better for those who don’t have a 
clue. 
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Materials: 
• TI-Nspire

TM
 CAS handheld technology (one per student) 

• TI-Nspire CAS Teacher Edition computer software and projector with data collection 
cables 

• Student worksheet: Exploring_Motion_with_the_CBR2_Student_Physics.doc 

• Calculator file: Exploring_Motion_with_the_CBR_2_Physics.tns 

• CBR 2
TM

 with appropriate cables and a few clamps (one CBR 2 per team of two or three) 

• Extra AAA and AA batteries and a battery tester (optional) 

• Ramps, balls, metersticks, cars, coffee filters, and other objects 

• Connect-to-Class, TI-Nspire Navigator, TI-Nspire Link with direct connect cable or unit-
to-unit cables to send the assessment file and collect the student documents with results  

 
 
 
 

Suggested Related Activities: 
To download any activity listed, go to education.ti.com/exchange and enter the number in 
the quick search box. 

• Rolling a Ball on an Inclined Plane — 8550 

• Various Activities found at TI Physics: http://www.tiphysics.com/  

• Two Exploration books: Math and Science in Motion: Activities for Middle School and 
Modeling Motion: High School Math Activities with the CBR, found at 
http://education.ti.com/educationportal/sites/US/sectionHome/activitybook_section_datac
ollection.html 

• Atomic Learning Tutorials: http://movies.atomiclearning.com/k12/ti_nspire/ 

• CBR 2 references at 
http://education.ti.com/educationportal/sites/US/productDetail/us_cbr_2.html 
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How to use the CBR 2 with the TI-Nspire Data Collection Application (Optional) 

You will need to establish a sequence for the students 
to follow as they collect data with the CBR 2 and their 
TI-Nspire. This requires a few TI-Nspire skills that the 
students may already have. These are the steps that 
they should follow as they collect data. 

1. Open a new document by pressing c and 
selecting New Document. If prompted to save or 
discard, choose the right choice. 

 

2. Select Notes as the first page of the document. 
Have the students write in the assignment name, 
date, team name, names of the team members, 
and other relevant information (part 1 or part 2). 

 

3. Have the students insert another Notes page, and 
on that page they should write the script for the 
motion that would produce the given graph (from 
part 1). 

 

 

4. Now the students should add a Graphs & 
Geometry page by pressing c (or / I)and 
selecting Graphs & Geometry. This is where they 
will test their script using the CBR 2. 

5. Plug the CBR 2 into the TI-Nspire handheld and 
cancel the pop-up screen by pressing e until 
the Cancel option is highlighted and then pressing 
·.  
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6. Now we will launch the Data Collection application 
again by pressing / D. We want to set up the 
data collection for the individual graph we have 
been assigned this time. 

7. Explore the settings available with the Data 
Collection application by pressing b when the 
Data Collection console is the point of focus (use 
/ e to change the focus from Graphs & 
Geometry to Data Collection as needed). 

 

8. You may adjust the time of the experiment from 
the Data Collection application by Selecting 
MENU > Experiment > Set Up Collection > 
Time Graph. Enter the values that your team 
thinks best to help match the graph. Use e to 
switch between the data entry boxes and the OK 
button. 

 

 

9. To adjust the CBR 2, select MENU > Sensors > 
Zero will set the distance currently being 
displayed by the CBR 2 at 0 meters. Then 
everything closer than that will read as a negative 
distance. To undo the zeroing of a probe, just 
select MENU > Experiment > New Experiment. 

 

 

10. Now we want to have the data that you collect 
displayed on the current Graphs & Geometry 
application. To do this, select MENU > 
Experiment > Display Data In > App(s) on 
Current Page. 
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11. After doing this, you will see the function entry line 
on Graphs & Geometry. To hide this, you will need 
to switch applications (/ e) and then use / 
G to hide it. This is a toggle, so you may bring 
the function entry line back with the same 
keystrokes. 

 

12. At this time, you could draw the line segments that 
represent the graph that you were given. This is 
what you will do in part 2 of the investigation. To 
draw, you would need to first set up the window as 
you want it from the Graphs & Geometry menu by 
selecting MENU > Window > Window Settings 
and then adjusting the values. Use e to move to 
different lines, and then highlight OK and press 
·. You may also adjust the window settings 
from the Graphs & Geometry screen by clicking 
on the numbers at the ends of the axes. 

 

 

13. To activate the Segment tool, select MENU > 
Points & Lines > Segment. Then, move to the 
location you want to start drawing and press x to 
start a segment and then again to end the 
segment. 
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14. When you are set to collect your data, switch to 
the Data Collection application (/ e) and 
then with the play button highlighted, press ·. 
The data collection will occur for the time interval 
you selected, and the data will appear as a scatter 
plot on the Graphs & Geometry screen. 

 

15. If you are far off your expectations or you just 
messed up, you can collect the data again. One 
thing that might happen is that the window will 
adjust after the data collection (the Data Collection 
application does a Zoom-Data). If this occurs and 
you have a good data set, you can just manually 
change the window back, as before. If you repeat 
the experiment, you need not worry about the 
window. To collect the data again, make sure your 
focus is on the Data Collection application and 
that the play button is highlighted. When you 
press ·, you will be asked whether to store or 
discard the data. Use e and select the Discard 
option. Data collection will start right after you 
make your choice. 

 

16. If you are successful, you will need to add a new 
problem to your document. If not, repeat the 
previous steps. To get the new problem, press 
/ c for the Tools menu (#) and select Insert 
to insert a second problem in the document. Then 
start the process over with the Notes page to 
describe the motion for the next graph. When you 
finish the second graph to your team’s 
satisfaction, insert another problem and continue 
through part 1. 

 

17. Don’t forget to save the document. Press / S 
and then select a name and folder. 
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Part 1 – Given a Distance vs. Time Graph, Write a Script to Describe the Motion 

1. In this part, the teams will be given seven graphs of distance vs. time data. Their job will 
be to write a script that, when followed, will produce the same graph. 

2. They will write each script in a problem in their TI-Nspire document, using one document 
for part 1 and another part 2. Each graph will then be associated with a problem number 
in the TNS file.  

3. After they write the script, they will add a Graphs & Geometry page and launch the Data 
Collection application to display in that page. See the instructions above.  

4. Once all the settings are made on the TI-Nspire and the team has arranged the CBR 2 
and the moving object(s), they should collect the data. An option here would be for the 
team to draw or graph a function on the Graphs & Geometry screen to represent the 
graph they were given before they collect the data. Since this is not exactly a Match Me 
activity, a sketch is not required. 

5. If the plot of the data is close to the given graph, they may move on. If they are off or they 
mess up the motion for some reason, they may repeat and discard the first data set. You 
might want them to add a Notes page after the data collection where they can reflect on 
their success or failures. 

6. When satisfied, add a new problem and continue through the seven graphs. They should 
save the document periodically using /S. 

7. When they are finished, have the teams save and then send the document to each person 
in the group and to the teacher. 

 

Part 2 – Given a Script for Motion, Make a Sketch of the Resulting Distance vs. Time 

1. This part should be done in a new document, and it is just the opposite of the first part. 
The teams will be given seven scripts for some motion, and they will need to sketch a 
graph that they believe will represent the distance vs. time plot for each script. 

2. You may want the teams to write the script again in a Notes page on their TI-Nspire to 
avoid confusion. They should then add a Graphs & Geometry page, launch the Data 
Collection application, and set up the data collection as in Part 1. In this part, there should 
be more consideration of the time needed to do the motion, so teams will probably want to 
adjust the time graph from 5 seconds. 

3. After all of the settings are made for the Data Collection application, the students should 
switch to the Graphs & Geometry application and adjust the window. As they consider the 
maximum distances, remind them that most motion should occur within 6 meters of the 
CBR 2. Then, as the last thing they do before collecting the data, they should use the 
Segment tool from the Graphs & Geometry menu to draw what they think will happen with 
the distance vs. time plot as a result of the described motion in front of the CBR 2. 

4. They should then switch to the Data Collection application, arrange the moving object(s), 
and then collect the data. 
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5. If their attempt is far off of the window settings they may lose part of their sketch due to 
the Zoom-Stat that occurred after the data collection. Have them adjust the window in 
Graphs & Geometry again if they think they were close, but if they know it was a bad run, 
they should just collect data again, discarding the last set of data. 

6. You might want them to add a Notes page after the data collection where they can reflect 
on their success or failures. 

7. When satisfied, add a new problem and continue through the seven scripts. They should 
save the document periodically using /S. 

8. When they are finished, have the teams save and then send the document to each person 
in the group and to the teacher. 

 

Part 3 – The Assessment 

1. Send the Exploring_Motion_with_the_CBR_2_Physics.tns to each person and have them 
answer the questions. Since it is a self-check, the teams can collaborate on the answers if 
they wish. 

2. Debrief the teams and the class using the assessment document and the documents from 
Part 1 and Part 2. What did they think they knew that was proved to be true and what did 
they think they knew that turned out to be false? 

 

Extensions – Creating Your Own 

1. Have the teams create a sketch of some motion over time and then describe how it could 
occur in a script. They would then swap sketches with another team and write a script. 
The teams would then compare scripts. 

2. Then the teams could write a script and make a sketch of what they think the distance vs. 
time plot would look like. They then should find another team, different from the team in 
step 1, and swap scripts. Each team would then make a sketch and then compare as 
before. 
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Activity Overview: 
• With this action/consequence/reflect .tns file, students will develop an understanding of 

kinetic energy, gravitational potential energy, and the conservation of mechanical energy. 
 
Materials: 
• TI-Nspire

TM
 CAS handheld 

• RollerCoasterEnergy_Physics.tns 
 

 

Frictionless Roller Coasters Depict Conservation of Mechanical Energy 

Press the play button to animate the frictionless roller coaster. Observe the bar graph. 
1. Describe what is happening to the kinetic energy K bar graph and the gravitational potential 

energy Ug bar graph. What connections can you make? 
 
 
 
 
2. Indentify the important parts of the graph on the 

right. 

a) Is this a distance versus time graph? ________ 

 

b) What variable is on the horizontal axis? ______ 

 

c) What is the vertical axis? _________________ 

 

d) How many meters above ground level is the roller coaster at the start? _____________ 

3. a) Describe the gravitational potential energy when the roller coaster is at its highest point. 

 

 

b) Describe the kinetic energy when time = 0 and the roller coaster is at its highest point. 

 

 

4. a) In the part of the roller coaster shown, how many times does Ug, the gravitational 
potential energy, equal K, the kinetic energy? 

 

b) Why? What is the approximate height when Ug = K? 
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Press pause. Grab the open point for time and manually move the roller coaster. 

5. Even though you cannot see what happens to the roller coaster from 9 to 10 seconds, use 
your observations of the energy bar graphs to explain what happens. (Does the roller 
coaster go up again or down? Explain how the bar graphs help you determine this. Can you 
tell about how high the roller coaster goes at the end of 10 seconds?) 

 

 

 

 

6. Gravitational potential energy is measured from some arbitrary ground level. Grab the small 
open point on the origin and move it up and down. Press play and observe the energy bar 
graphs.  

a) What happens to the gravitational potential energy bar graph? 

 

 

 

b) Can potential energy ever be negative? 

 

 c) When the ground level is changed, does this affect the kinetic energy? If so, how?  

 

d) Can the kinetic energy ever be negative? 

 

7. Since kinetic energy is the energy of motion, where is the roller coaster moving the fastest? 
Explain your answer using the energy bar graphs. 

 

 

 

8. The total mechanical energy of a system is the sum of the kinetic and potential energies. 
Describe the sum total of the two bar graphs for this frictionless roller coaster. 

 

 

9. What did you learn from this exploration activity? 
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Activity Overview: 
• With this action/consequence/reflect TNS file, students will explore the relationship 

between kinetic energy and gravitational potential energy for a frictionless roller coaster. 
• Students will develop an understanding of kinetic energy, potential energy, and 

conservation of energy. 

Materials: 
• TI-Nspire

TM
 CAS handheld 

• RollerCoasterEnergy_Physics.tns 

Related Activity: 

• Potential and Kinetic Energy by Peter Fox #9601 
 

 

Frictionless Roller Coasters Depict Conservation of Mechanical Energy 

Press the play button to animate the frictionless roller coaster. Observe the bar graph. 
1. Describe what is happening to the kinetic energy K bar graph and the gravitational potential 

energy Ug bar graph. What connections can you make? 

This open-ended opening question allows students to make any initial observations. The 
following questions will help students take note of important aspects of the graphs. A 
possible answer may be: The kinetic energy bar goes up when the gravitational 
potential energy bar goes down. The lower the roller coaster is, the greater the kinetic 
energy. When the coaster is high, Ug is large. 

 
2. Indentify the important parts of the graph on the 

right. 

a) Is this a distance versus time graph? 

No. 

b) What variable is on the horizontal axis? 

Distance in the x-direction 

c) What is the vertical axis?  

Distance in the y-direction, measured in meters 

d) How many meters above ground level is the roller coaster at the start?   

25 meters 

3. a) Describe the gravitational potential energy when the roller coaster is at its highest point. 

The gravitational potential is at a maximum. 

b) Describe the kinetic energy when time = 0 and the roller coaster is at its highest point. 

The kinetic energy is at a minimum. 
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4. a) In the part of the roller coaster shown, how many times does Ug, the gravitational 
potential energy, equal K, the kinetic energy? 

They are equal three times: once at about 1.8 seconds, once at 5.6 seconds, and 
again at 6.5 seconds. 

b) Why? What is the approximate height when Ug = K? 

Ug = K when the roller coaster is at half of its maximum height above the ground. 
Height = 12.5 meters 

Press pause. Grab the open point for time and manually move the roller coaster. 

5. Even though you cannot see what happens to the roller coaster from 9 to 10 seconds, use 
your observations of the energy bar graphs to explain what happens. (Does the roller 
coaster go up again or down? Explain how the bar graphs help you determine this. Can you 
tell about how high the roller coaster goes at the end of 10 seconds?) 

The potential energy bar graph increases again, and the kinetic energy bar graph gets 
smaller. This indicates that the roller coaster is going back up a hill. It appears to be 
about the same gravitational potential energy it had when the coaster was at 10 
meters. 

6. Gravitational potential energy is measured from some arbitrary ground level. Grab the small 
open point on the origin and move it up and down. Press play. Observe the energy bar 
graphs.  

a) What happens to the gravitational potential energy bar graph? 

When the ground level is raised, the potential energy gets smaller. If the ground 
level is lowered, the potential energy gets larger. 

b) Can potential energy ever be negative? 

Yes, Ug can be negative when the ground level is above the current height. 

c) When the ground level is changed, does this affect the kinetic energy? If so, how?  

No, the kinetic energy is unaffected when the ground level is changed. 

d) Can the kinetic energy ever be negative?  

No. Students will at least observe the kinetic energy is not negative for this situation. 
When students learn K= ½mv2, they should again realize kinetic energy cannot be 
negative. 
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7. Since kinetic energy is the energy of motion, where is the roller coaster moving the fastest? 
Explain your answer using the energy bar graphs. 

The kinetic energy bar graph is the largest when the y-position is the smallest. It is 
moving the fastest at the bottom of the hills. 

8. The total mechanical energy of a system is the sum of the kinetic and potential energies. 
Describe the sum total of the two bar graphs for this frictionless roller coaster. 

Mechanical energy appears to be conserved. The Ug bar graph appears to be 
decreasing at the same rate the K bar graph is increasing. The maximum Ug looks like 
it is equal to the maximum K, but they occur at different times. Qualitatively, the sum 
of the kinetic and potential energies appears to be constant. 

For further discussion: Ask students, “What do you think would be different about the bar graph 
if this was not a frictionless roller coaster? If there was friction, how would that affect the total 
energy?” The total energy would not stay constant. Friction would reduce the total 
amount of kinetic energy in the system by slowing the roller coaster down. The 
maximum kinetic energy would be less than it is in the current simulation. 

9. What did you learn from this exploration activity? 

This may have served as an introduction to kinetic, potential, and mechanical energy 
and its conservation. Students may have become better at interpreting bar graphs.  

 

41



 

©2009 Texas Instruments Incorporated  education.ti.com/activities 

This page was intentionally left blank. 

42



 

Ohm’s Law 
Physics – Student Activity 

Name __________________________ 

Class __________________________ 
 

 

©2009 Texas Instruments Incorporated Page 1 education.ti.com 

 

Activity Overview: 
In this activity you will explore the effects of changing resistance or voltage in a simple DC 
circuit and develop the relationship between the basic quantities of voltage, resistance, and 
current. 
 
Materials: 
• TI-Nspire

TM
 CAS handheld 

• Ohms_Law_Physics.tns 
 

 

Problem 1 

Open the Ohms_Law_Physics.tns file on your TI-Nspire 
handheld. Read the instructions on pages 1.1 and 1.2. On 
page 1.3 is a schematic diagram of a simple DC circuit. 
You will explore the effect of changing resistance by 
dragging point R and noting the change in values on the 
screen. Move R to the extremes and experiment slowly 
with different positions of R. On the following pages, 
answer the questions on the screen by using the up or 
down arrow keys to highlight your answer, and press x to 
select that answer. 

As you move point R, data are being captured and 
recorded in a spreadsheet on page 1.13. This data can be 
plotted on page 1.10. 

On page 1.10, press e to move between the axis 
variable selection boxes. Select ohms for the horizontal 
axis and amps for the vertical axis. Consider the shape of 
this graph and what it means mathematically. 

On page 1.12, you are asked to move to the spreadsheet 
on page 1.13. In the formula cell, enter the formula 
=amps·ohms and then press ·. (The variables can be 
selected by pressing the h button, or they can be typed 
in.) What does the value calculated in Column C 
represent? Look back to the original circuit on page 1.3 for 
a clue. 
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Problem 2 

In Problem 2, you use a similar circuit, but you change the voltage. On page 2.2, you will find a 
voltage regulator. Drag the end of the needle to change the source voltage. Again, experiment 
with a wide range of voltages and watch what other quantities change values and in what 
manner.  

Again, data is captured as you vary the voltage. Plot this data on page 2.7 in a similar manner 
to what you did in Problem 1. 

What does the shape of this graph suggest? 

Do a linear regression by selecting MENU > Analyze > Regression > Show Linear (mx+b). 

Look at the value of the slope of the equation. What quantity does the value represent? Look 
back to the original circuit on page 2.2 for a clue. 

The equation, y = mx does not represent the quantities being used. Rewrite this equation using 
the true quantities: voltage (V), current (I), and resistance (R). 

This equation represents Ohm’s law. 

Ohm’s law is a relationship between the quantities V, I, and R. The relationship between the 
units can also be determined from the equation. Answer the question on page 2.11 relating to 
the units. On page 2.12, you are asked to rearrange the units and Ohm’s law equations. 
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Activity Overview: Ohm’s Law 
In this activity, students will explore the effects of changing resistance or voltage in a simple DC 
circuit and will develop the relationship between the basic quantities of voltage, resistance, and 
current. 
 
 
 
 

Teacher Preparation and Notes: 
• Estimated time for activity: 20–30 minutes 

• This activity requires that students have Ohms_Law_Physics.tns file on their TI-Nspire 
handhelds. 

• Students need little preparation for this activity. It can be used as an exploratory learning 
activity. 

• Students may work individually, or in pairs with one handheld. 

• To download the student TI-Nspire document(s) (.tns file(s)), student worksheet, 
and standards and textbook alignments, go to education.ti.com/exchange and 
enter “12870” in the quick search box. 

 
Materials: 

• TI-Nspire
TM

 handheld technology 

• TI-Nspire CAS handheld technology 

• Ohms_Law_Physics.tns 
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Problem 1 

Open the Ohms_Law_Physics.tns file on your TI-Nspire 
handheld. Read the instructions on pages 1.1 and 1.2. On 
page 1.3 is a schematic diagram of a simple DC circuit. 
You will explore the effect of changing resistance by 
dragging point R and noting the change in values on the 
screen. Move R to the extremes and experiment slowly 
with different positions of R. On the following pages, 
answer the questions on the screen by using the up or  
down arrow keys to highlight your answer, and press x to select that answer. 

Teacher Tip: Use this opportunity to discuss terminology and the symbols used in the 
schematic diagram. Ask students to predict what will happen before they drag point R. 

Answers: 
1.4: resistance 1.5: current 
1.6: voltage 1.7: resistance increases 
1.8: false 

As you move point R, data are being captured and 
recorded in a spreadsheet on page 1.13. This data can be 
plotted on page 1.10. 

Teacher Tip: The TI-Nspire software uses variables of 
several types. Current is used as a value variable from 
page 1.3. The same name cannot be used for a different 
variable, such as the list variable now called ohms in 
column A of the spreadsheet. To avoid confusion, have a 
discussion with students about this naming. 

On page 1.10, press e to move between the axis variable selection boxes. Select ohms for 
the horizontal axis and amps for the vertical axis. Consider the shape of this graph and what it 
means mathematically. 

Answer: 
1.11: inversely proportional 

On page 1.12, you are asked to move to the spreadsheet 
on page 1.13. In the formula cell, enter the formula 
=amps·ohms and then press ·. (The variables can be 
selected by pressing the h button, or they can be typed 
in.) What does the value calculated in Column C 
represent? Look back to the original circuit on page 1.3 
for a clue. 

Answer: 
1.12: Column C should have a constant value equal to the voltage from page 1.3. 
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Problem 2 

In problem 2, you use a similar circuit, but you change the voltage. On page 2.2, you will find 
a voltage regulator. Drag the end of the needle to change the source voltage. Again, 
experiment with a wide range of voltages and watch what other quantities change values and 
in what manner.  

Answers: 
2.3: current increases 
2.4: As voltage is increased, current increases. This suggests a direct proportion. 

Again, data are captured as you vary the voltage. Plot this data on page 2.7 in a manner 
similar to what you did in problem 1.  

What does the shape of this graph suggest? 

Answer: 
2.8: This graph is linear, meaning that the relationship is a direct proportion. 

Do a linear regression by selecting MENU > Analyze > Regression > Show Linear (mx+b). 

Look at the value of the slope of the equation. What quantity does the value represent? Look 
back to the original circuit on page 2.2 for a clue. 

Answer: 
2.9: The slope of the equation will be circuit resistance. 

The equation y = mx does not represent the quantities being used. Rewrite this equation 
using the true quantities: voltage (V), current (I), and resistance (R). 

This equation represents Ohm’s law. 

Teacher Tip: The value of b should be 0 but may appear as a very small number (e.g.,  
2.4E–14) with a large negative power of 10. Discuss this with students so that they are 
comfortable ignoring b. 

The equation y = mx becomes V = RI. Discuss the variations of this equation. 

Ohm’s law is a relationship between the quantities V, I, and R. The relationship between the 
units can also be determined from the equation. Answer the question on page 2.11 relating to 
the units. On page 2.12, you are asked to rearrange the units and Ohm’s law equations. 

Answer: 
2.11: 1 V = 1 A·Ω 
2:12: The variations of the unit relations and Ohm’s law are: 
       1 Ω = 1 V/A                V = IR 
      1 A = 1 V/Ω                I = V/R 
                                        R = V/I 

Wrap Up: 

• This is a simulation that can be used to discover and discuss the relationships between V, 
I, and R. This applies to a simple DC circuit only. 
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Light at a Distance 
Physics – Student Activity 

Name __________________________ 

Class __________________________ 
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Activity Overview: 
• In this investigation your team will design an experiment that will use a light probe and the 

TI-Nspire handheld to reveal the relationship between light intensity and distance. Once 
your design has been completed, your teacher will approve, modify, or reject it. Upon 
approval of your experiment, you will conduct it as a team and then analyze your results. 
Then you will compare your results with known relationships and parse your units to see if 
your data are consistent with accepted values. 

 
Materials: 

• TI-Nspire
TM

 CAS handheld technology (one per student) 

• Light source 

• One light probe and EasyLink per group 

• Tape 

• Tape measure or meterstick 

• Unit-to-unit cable 
 

 
 
Some skills you will need: 

- Create a new document on the TI-Nspire 

- Save a document, give it a name, and create or find a folder 

- Launch the Data Collection application 

- Adjust the settings from the Data Collection application menu 

- Use events with entry for data collection 

- Add a new application to your problem 

- Use various tools in Data & Statistics 

- Do a regression and plot a function in Data & Statistics 

- Load data into Lists & Spreadsheet 

- Start and stop data collection 

- Send and receive files from your TI-Nspire 

- Use units in the Calculator application 
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TI Light Sensor Specifications: The TI light sensor uses a phototransistor to measure 
relative irradiance. The units of irradiance are milliwatts per square centimeter. The light 
sensor’s output is a voltage that is linearly proportional to the amount of irradiance it senses. 
The range of light over which the sensor is sensitive is 10 mW/cm2 to 1 mW/cm2. The auto-
ID resistor in the sensor causes the automatic conversion of the measured voltage to 
relative units. The sensor is direction dependent and achieves the highest output when the 
end of the sensor is pointed directly at the light source. The light sensor is sensitive in the 
visible and near-infrared (IR) light range. The light sensor is designed to work in air only—it 
is not waterproof. The light sensor readings are also sensitive to temperature. 
 
 

Experimental Design 

1. Gather your team and discuss how you plan to attack the problem of determining the 
relationship between light Intensity and distance. 

2. Start a new document on your TI-Nspire and create a first page using the Notes application. 
Report on this page the assignment name, date, team name, names of the team members, and 
other relevant information. 

3. Design the experiment and explain your approach by using the Notes application and other 
applications as needed. Include a drawing in Graphs & Geometry. If you don’t have an artist on 
your team, make sure you label your drawing. Include the variables you can determine in the 
experiment and how you plan to control them. 

4. Identify any safety issues and how your team will address them. 

5. When you finish the design, save the document, /S, and send it to all team members and 
the teacher. Discuss your design with the teacher and make any modifications required. Note: 
The first time you save, you will need to give the document a name and place it in the correct 
folder. 
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Data Collection 

1. Once you have your experiment approved, set it up as you had proposed. 

2. Open a new document on your TI-Nspire (or just add a problem to the Experimental Design 
document) and create a first page using the Notes application. Report on this page the 
assignment name, date, team name, names of the team members, and other relevant 
information (unless you have already done this in the Experimental Design part of the 
document). 

   
 

3. As you collect data, make sure you are getting the light most directly on your light probe. You 
can do this by moving it slightly and looking for the position that gives the highest value. If you 
are too close to the light source, you will get a reading of 1. Make sure you move so that the 
highest reading you get is less than 1. 

4. Save the document periodically as you move through the experiment, and add Notes pages 
to help document your work. 

5. If you make a mistake with your data entry, it might be best to just start over or get your 
teacher to help you to fix it after you finish. 

 

Data Analysis 

1. Now that you have your data, save the document and send it to each person in the group. To 
send, hook up to another handheld and press / c to get the Tools menu (#), and then 
select File > Send. 
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2. In the Data & Statistics application, you can look at the data if you don’t already have it set 
up. To set up the plot, move your cursor to the bottom and select the event list. Then move to 
the left and select light1. 

   
 

3. Now you may guess the function shown by the pattern in the plot by selecting MENU > 
Analyze > Plot Function, as shown, and keying in the guess. 

   
 

4. If you want to do a regression, select the appropriate mathematical model from the menu 
after selecting MENU > Analyze > Regression. This value will be stored as a variable for later 
use. You might want to explore different types of regressions until you get a nice fit and then 
return to the guess method. Each guess will be stored in the problem, but only the last 
regression will appear in the variables list as stat.regeqn. 
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5. Once you determine the best equation for the pattern in the data, move to the Calculator and 
after doing some research on what equations you should have discovered, compare what you 
found with the theory. Use the Comment tool to help document what you find. Select MENU > 
Actions > Insert Comment. 

    
 

6. Once you think you have discovered the true relationship between light Intensity and 
distance, try to parse the units in your equation. You may access the units built into your CAS 
handheld by using the underscore (/_) with the units attached. You may also pull units from 
the catalog (k). Note that the units are in SI unless you change the settings under System Info 
(HOME > System Info). 

   
 

7. Your team may also want to look at your data in a list. To do this, add a Lists & Spreadsheet 
page by pressing HOME and selecting Lists & Spreadsheet. Move to the diamond line and 
press =h to select the distances (events). Repeat this in the second column for the light 
data. 
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8. You might want to name the columns as shown. Pick names that might be sensible. Make 
sure you are in the header of the column. This is where you could edit the data by clearing the 
diamond line and breaking the association between these new names you created and the 
stored lists from the data collection. Then you may enter a cell and delete, change, or null. 
Remember that the plots shown in Data & Statistics would need to change to show these new 
lists. 

   
9. When you have finished your analysis, add another Notes page and explain what you 
discovered and what it means.  

 

10. Save this final document and send it to each person in the team and to your teacher. 

 

Extensions – Other Experiments with Light (Optional) 

• Design an experiment that will verify the wattage established for various light bulbs. Is a 
60-watt bulb really 60 watts?  

 

• Design an experiment to look at different 75-watt light bulbs and determine how the clear, 
frosted, incandescent, florescent, and other types vary in Intensity. 

 

• Design an experiment that uses different-colored filters or polarizers to see how the intensity 
of a light varies. 

 

• Design an experiment that verifies the inverse square law for motion, magnetism, or electric 
change. 
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Activity Overview: Light at a Distance 
This investigation has two goals. For the first part, we want to involve students in the 
experimental design process. We will set up some parameters, but the teams should design, get 
approved, and implement an experiment that answers the question, “What is the relationship 
between light intensity and distance?” 

For the other part, we are trying to expand student understanding of the inverse square law and 
to help them see this outside of Newtonian mechanics, discussing the grand unified theory and 
why it might actually be true. 
 
 
 
 

Teacher Preparation and Notes: 
• Estimated time for activity is one class period if students are familiar with the TI-Nspire 

and the Data Collection application. 

• You will need to collect some light sources for the students to use. Have these available 
for the teams, but don’t force their use. Just have them if they want them in their 
designs.  

• You will need table space for the data collection and power supplies if you use light 
sources other than flashlights. Flashlights that allow you to spread the beam from wide 
to narrow work well. Small distances work better than long ones. Think centimeters 
rather than meters. 

• A list of TI-Nspire skills appears in the student worksheet.  

• TI Light Sensor: The TI light sensor uses a phototransistor to measure relative 
irradiance. The units of irradiance are milliwatts per square centimeter. The light 
sensor’s output is a voltage that is linearly proportional to the amount of irradiance it 
senses. The range of light over which the sensor is sensitive is 10 mW/cm2 to 1 
mW/cm2. The auto-ID resistor in the sensor causes the automatic conversion of the 
measured voltage to relative units. The sensor is direction dependent and achieves the 
highest output when the end of the sensor is pointed directly at the light source. The light 
sensor is sensitive in the visible and near-infrared (IR) light range. This means you can 
use it with IR-emitting diodes as well as all visible light sources. The light sensor is 
designed to work in air only—it is not waterproof. The light sensor returns relative 
readings, not absolute irradiance readings. Values may vary from light sensor to light 
sensor. The light sensor readings are also sensitive to temperature. 

• You will need to demonstrate data collection with the TI-Nspire using the TI-Nspire 
software. It is best to use the Teacher Edition in the SmartView/Emulator mode so 
students can see which keys you press. Using the EasyLink with the TI light probe with 
the computer requires the USB mini-A to standard-A adapter or the Go!Link.  

• You will want to use teams of 3 or 4 as you do this investigation. 
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Materials: 
• TI-Nspire

TM
 CAS handheld technology (one per student) 

• TI-Nspire CAS Teacher Edition computer software and projector with data collection 
cables 

• Light sources (various) 
• Student worksheet Light_at_a_Distance_Student_Physics.doc 

• One light probe and EasyLink per group of three or four 
• Tape 
• Tape measure or meterstick 
• Connect-to-Class, TI-Nspire Navigator, TI-Nspire Link with direct connect cable or unit-

to-unit cables to send the assessment file and collect the student documents with results  
 
 
 
 

Suggested Related Activities: 
To download any activity listed, go to education.ti.com/exchange and enter the number in 
the quick search box. 

• Light Intensity — 12336 

• Various Activities found at TI Physics: http://www.tiphysics.com/  

• Light at a Distance: Distance and Light Intensity — 3987 

• WATT’s the Deal? — 4030 
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Part 1 – The Set 

Ask the students some questions about light and distance: 

• Have them find the brightest light source (the sun?) and explain how they know it is the 
brightest.  

• What units are used for brightness?  

• What is the meaning of these units? 

• How do you measure light intensity? (watts/m2) 

• Do you know what happens to light intensity as a light comes closer to your? Moves 
away from you? Is this change linear? Exponential? Quadratic? (Power) 

• How far away does a light need to be from for you to be unable to see it? During the 
day? The night? 

• What is the effect of ambient light when you consider the intensity of a single light 
source? 

• What is the difference between brightness, flux, and intensity when we speak of light? 
[see Brightness, Luminance, and Confusion from Information Display, March 1993, 
Charles P. Halsted: http://www.crompton.com/wa3dsp/light/lumin.html] 

• What is GUT? (grand unified theory) 

 

Note: You could place these questions in a TI-Nspire document as open response or even 
multiple guess. 

Part 2 – TI-Nspire Skills 

Students will need to be able to move around in the TI-Nspire environment. A list of skills is on 
the student worksheet. Some of these are explained below. 

To launch the Data Collection application, usually you just need to plug it into the TI-Nspire. 
Connect the EasyLink and the light probe, and then in a new document, plug the EasyLink into 
the TI-Nspire. This will result in the Auto Launch shown. Select Data & Statistics. If the Auto 
Launch does not appear, you can use /D to get this screen. 
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The students will need to use events with entry for data collection. To set this up, select MENU 
> Experiment > Set Up Collection > Events with Entry 

 
Now when you start data collection (by pressing · when the play button is highlighted), you 
will see a file cabinet that is highlighted. When the reading stabilizes, you can capture this value 
by pressing · and keying in the distance to the light source. In this instance, we have 15 cm. 

   
Once the team has collected all of the data needed, they should e to the stop button and press 
·. If there is a misstep, the students could repeat the whole data collection or they could just 
redo the particular distance again, deleting the data later. This is much more complicated, and 
for a novice user it would probably be easier to just start over. When you are finished with the 
data collection, just e over to the X button and press ·. 
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From the Data & Statistics application, the students can guess a function that models the data, 
or they may do a regression. To plot the guess, select MENU > Analyze > Plot Function, as 
shown, and key in the guess. 

   
For the regression, select the appropriate mathematical model from the menu after selecting 
MENU > Analyze > Regression. This value will be stored as a variable for later use. Students 
might explore different types of regressions until they get a nice fit and then return to the guess 
method. Each guess will be stored in the problem, but only the last regression will appear in the 
variables list as stat.regeqn. 

   
Students may also want to look at the data in a list. To do this, they should add a Lists & 
Spreadsheet page by pressing HOME and selecting Lists & Spreadsheet. Move to the 
diamond line and press =h to select the distances. Repeat this in the second column for the 
light data. 
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You might want to name the columns as shown. Pick names that might be sensible. Make sure 
you are in the header of the column. This is where you could edit the data by clearing the 
diamond line and breaking the association between these new names you created and the 
stored lists from the data collection. Then you may enter a cell and delete, change, or null. 
Remember that the plots shown in Data & Statistics would need to change to show these new 
lists. 

   
Once they have their relationship established, they can parse it in the Calculator application 
(press c and select Calculator to insert a Calculator page.). 

  
Units can be used on your data by using the underscore (/_) with the units attached. You 
may also pull units from the catalog (k). Note that the units are in SI unless you change the 
settings under System Info (c8). 
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Part 3 – Experimental Design 

1. Once the students have a clear idea of how to use the technology and what the question is, 
let them team up and start the design process. Have the students describe with drawings the 
experiment that they want to do. Ask them to list variables and how they will control them so that 
only light intensity and distance influence the data. The students should write and draw in the 
TI-Nspire environment using the appropriate applications (Notes, Graphs & Geometry, etc.). 
This could be problem 1 in their lab document, moving on to problem 2 for the actual 
experiment, when approved. 

2. Once the design is done, the students will send you the document for comment using 
Connect-to-Class, Link software, or just unit-to-unit. You might want to have the team present to 
the class their design by opening their file on the Teacher Edition software or using the 
TI-Nspire overhead panel. This would allow for peer review but should only be done after all 
teams have completed their designs. 

3. Approve, modify, or reject the design and then proceed based on your decision. 

 

Part 4 – Data Collection 

1. Once the team has approval of their design, they should collect the materials they need and 
collect the data. Make sure they follow their procedure and that they acknowledge any safety 
issues that came up in the discussion of the design. 

2. After successful data collection, the team should put up their equipment, straighten up their 
work area, save the document, and send the document to the each team member. 

 

Part 5 – Data Analysis 

1. This part should be done by the team, but each team member might experiment with the 
data. The final analysis should occur in the document that will be submitted by the team. 

2. The students should do some research on mathematical models that they would expect to 
see in this data. This should lead them to the inverse square law and a power function. 

3. Using the Calculator, the teams should try to identify the units in the parts of the equation. In 

the case of the function shown, it is clear that the power should be –2 and that 5 is 
4
P

π
, with the 

distance in centimeters and the intensity in milliwatts. 
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Extensions – Other Experiments with Light 

• Have the students design an experiment that will verify the wattage established for various 
light bulbs. Is a 60-watt bulb really 60 watts? 

• Have the students design an experiment to look at different 75-watt light bulbs and 
determine how the clear, frosted, incandescent, florescent, and other types vary in Intensity. 

• Have the students design an experiment that uses different-colored filters or polarizers to 
see how the intensity of a light varies. 

• Have the students design an experiment that verifies the inverse square law for motion, 
magnetism, or electric change. 
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Activity Overview: 
• There is a force F between any two masses (m1 and m2). This force F depends on the 

distance r between the centers of the two masses.  
• Explore this relationship by moving the open point to change the distance. 
 

Materials: 
• TI-NspireTM CAS handheld 
• LawOfGravity_Physics.tns 

 

 

Part 1 – Move the Planet 

Advance to page 1.2, whose screen is shown at right. 
Press /x to grab the open point in mass2. Move 
this point and observe the relationship between the 
distance and the force.  

 
1. As the distance between the two masses is 

decreased, what happens to the force? 
 
 
 
2. True/False: If the distance is doubled, the force is 

cut in half. 
 

 

3. Describe the relationship between the force and the distance between the masses. In your 
description, also discuss the direction of the force. 

 

 

 

Part 2 – Change Distance and Mass 

You can answer the self-check questions. Then advance to page 2.2. You can move the same 
point to adjust the distance. This time the distance will jump to the indicated values. 

The mass can also be changed by clicking twice on mass1 or mass2 and entering a different 
number. 

4. When m1 and m2 are separated by a distance r, the force of attraction between them is F. If 
the distance r between the two masses is cut in half, what is the force? 

 

5. If the distance between the two masses is a third of r, what is the force? Show work to 
explain your answer. Use the formula on page 2.2 to show work. 
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Answer the following question on page 2.5. To toggle over to the calculator panel of page 2.5, 
press /e. Give the decimal approximation for your answer. 

6. What would the distance between the centers of the two masses need to be for the force to 
be reduced by a factor of 2? (In other words, what distance makes the force 0.5F or F/2?) 

 

Use page 2.2 to help you answer the following questions and to help you explain your answers. 

7. What happens to the force when the distance is doubled? Tripled? Quadrupled? 

 

 

 

Move m2 back to position r. Double-click on the text that says mass2=1. Arrow over to the end 
and use backspace (.) to remove the 1. Press 2 and then ·. 

8. a) What happens to the force when one of the masses is doubled? Explain. 

 

 

b) What happens to the force when both masses are doubled? Explain. 

 

 

9. Force F is exerted between m1 and m2 when they are separated by distance r. 

a) What is the force when m2 is tripled and r is doubled? 

 

b) What is the force when m1, m2, and r are doubled? 

 

c) How could you get a force of 4/3F? 

 

10. a) Notice what happens to the size of the planet when the mass is increased. For example, 
change m2 to 8 or 16. Does this affect the distance r between the two planets? Explain. 

 

 

b) Write about what you learned by doing this activity. 
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Activity Overview: 
• There is an attractive force F between any two masses (m1 and m2). This force F depends 

on the distance r between the centers of the two masses. It is an inverse square law 
relationship. Students will explore this relationship by moving the open point to change the 
distance. 
 

Materials: 
• TI-Nspire

TM
 CAS handheld 

• LawOfGravity_Physics.tns 
 

 

Part 1 – Move the Planet 

Students are advised to advance to page 1.2, whose 
screen is shown at right. Press /x to grab the open 
point in mass2. Move this point and observe the 
relationship between the distance and the force.  

Students can answer the following six questions on 
their TI-Nspire. The answers of these self-check 
questions can be checked by pressing Menu > Check 
Answer. 

1. As the distance between the two masses is 
decreased, what happens to the force? 
The force increases. 

2. True/False: If the distance is doubled, the force is 
cut in half. 
False; the distance increases by a factor of 4 
when the distance between the centers of the 
two masses decreases by a factor of 2. 

3. Describe the relationship between the force and the distance between the masses? In your 
description, also discuss the direction of the force. 
Because the ATTRACTIVE force decreases as the distance increases, it is an inverse 
relationship. But actually it is an INVERSE SQUARE LAW RELATIONSHIP. 

Students will explore more about what this inverse square law means in the next part. 

Part 2 – Change Distance and Mass 

Students will advance to page 2.2. They can move the same point to adjust the distance. This 
time the distance will jump to the indicated values. The mass can also be changed by clicking 
twice on mass1 or mass2 and entering a different number. 

4. When m1 and m2 are separated by a distance r, the force of attraction between them is F. If 
the distance r between the two masses is cut in half, what is the force? 
4F 
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5. If the distance between the two masses is a third of r, what is the force? Show work to 
explain your answer. Use the formula on page 2.2 to show work. 

9F = 1
2

1
11
93

m m
G F

r

=
⎛ ⎞
⎜ ⎟
⎝ ⎠

 

Question 6 is to be answered on page 2.5. To toggle over to the calculator panel of page 2.5, 
press /e. Give the decimal approximation for your answer. 

6. What would the distance between the centers of the two masses need to be for the force to 
be reduced by a factor of 2? (In other words, what distance makes the force 0.5F or F/2?) 

2  ≈ 1.414 

Students will use page 2.2 to help them answer the following questions and to help you explain. 

7. What happens to the force when the distance is doubled? Tripled? Quadrupled? 
Doubled r gives F/4, tripled r results in F/9, and quadrupled r gives F/16. 

Move m2 back to position r. Double-click on the text that says mass2=1. Arrow over to the end 
and use backspace . to remove the 1. Press 2 and then ·. 

8. a) What happens to the force when one of the masses is doubled? Explain. 
With the relationship F = Gm1m2/r2, if one of the masses is doubled, the force is 
doubled. 

b) What happens to the force when both masses are doubled? Explain. 
The force is quadrupled because 2 × 2 = 4. Masses vary directly with the force. 

9. Force F is exerted between m1 and m2 when they are separated by distance r. 

a) What is the force when m2 is tripled and r is doubled? ¾F 

b) What is the force when m1, m2, and r are doubled? No change. It would be F. 

c) How could you get a force of 4/3F? Teachers may need to provide the hint 4/3F = 12/9F.
m1 = 3, m2 = 4 (or some other variation that multiplies to 12), and the distance is 3r 

10. a) Notice what happens to the size of the planet when the mass is increased. For example, 
change m2 to 8 or 16. Does this affect the distance r between the two planets? Explain. 
The distance r doesn’t depend on the size of the planet or the masses. The 
distance is measured from the center of one mass to the center of the other. 

b) Write about what you learned by doing this activity. 
Gravity is an attractive force that varies directly with the mass and inverse square 
with the distance of separation. 
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Activity Overview: 
In this activity, students explore the relationship between force, charge, and distance for two 
charged particles, i.e., Coulomb’s law. Students observe how force changes with distance by 
moving a charged particle. By fitting the data collected for force vs. distance to a power 
regression equation, students determine that electrical force is inversely proportional to distance 
squared. After determining the dependence of electrical force on charge, the students are able 
to write the Coulomb’s law equation. Next, students see how force changes with like and unlike 
charges. The activity ends with an application of Coulomb’s law to solve a problem involving two 
charged particles and a test charge. 
 
 

 
Teacher Preparation and Notes: 
Before carrying out this activity, review the units of force and electrical charge. You may also 
want to review the representation of forces with vectors. 

• The screenshots on pages 2–6 demonstrate expected student results. Refer to the 
screenshots on pages 7 and 8 for a preview of the student TI-Nspire document (.tns file). 

• This activity is designed to be teacher led, with students following along on their 
handhelds. You may use the following pages to present the material to the class and 
encourage discussion. Note that the majority of the ideas and concepts are presented 
only in this document, so you should make sure to cover all the material necessary for 
students to comprehend the concepts.  

• Students may answer the questions posed in the .tns file using the Notes application or 
on blank paper. 

• In some cases, these instructions are specific to those students using TI-Nspire 
handheld devices, but the activity can easily be done using TI-Nspire computer software. 

• To download the .tns file, go to education.ti.com/exchange and enter “9747” in the 
search box. 

 

Materials: 
To complete this activity, each student will require the following: 

• TI-Nspire™ technology 

• Pen or pencil 

• Blank sheet of paper 
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The following questions will guide student exploration in this activity: 

• How is electrical force related to the distance between charged particles? 

• How is electrical force related to the magnitudes of the charges of separated particles? 

• How do the signs of the charges affect electrical force? 

In Problem 1 of the activity, students vary the separation of two charged particles. They observe 
the change in electrical force with varying separation. With a manual data capture of force and 
distance data, a graph of force vs. distance, and a power regression, students determine the 
mathematical relationship between force and distance. In Problems 2 and 3, students will vary 
the charges of the particles. This leads to the writing of Coulomb’s law. Problem 4 is an 
investigation of the effects of like and unlike charges. In the final part of the activity, students 
move a test charge around two charged particles, one with a known charge and the other with 
an unknown charge, and observe the net force on the test charge. They are then asked to 
determine the unknown charge. 

Problem 1 – Electrical Force and Distance  

Step 1. Students should open the file 
PhysWeek29_CoulombsLaw.tns and read the first two 
pages. Page 1.3 shows two positively charged particles 
separated by a distance r. Students should drag the smaller 
particle to vary the separation between the two charged 
particles. Then they should answer question 1. 

Q1. Describe how F changes as r changes. 

A. F increases as r decreases. 

Step 2. Next, students should return to page 1.3 and do a 
manual capture of force and distance data. To capture a data 
point, students should press /^. Students should 
capture at least 10–15 data points. The data will be stored in 
the spreadsheet on page 1.5. On page 1.8, students should 
make a graph of force1 vs. r1. Then they should use the 
Power Regression tool (Menu > Analyze > Regression > 
Show Power) to find a power regression that fits the data. 
Then they should answer questions 2 and 3. 

Q2. Write the equation for electrical force (F) as a function of distance (r). 

A. 
2

13.485
F =

r
 

Q3. What type of relationship is this? What are some other phenomena that show a similar 
relationship? 

A. It is an inverse square relationship. Encourage student discussion of other inverse square 
phenomena, such as gravitational force vs. distance and light intensity vs. distance. 
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Problem 2 – Effects of Changing One Charge on Electrical Force 

Step 1. Next, students should move to page 2.1 and read 
the text there. Then they should move to page 2.2, which 
again shows two positively charged particles separated by a 
distance r. In this simulation, r is fixed, but students can vary 
the charge on the smaller particle (q1). Students should vary 
q1 and observe the effects on F. Then they should answer 
questions 4 and 5.  

Q4. If q1 is doubled, from +1 to +2 μC, what is the effect on the force? 

A. The force doubles. 

Q5. Describe how doubling q1 would affect the equation relating F and r.  

A. The value of the constant would change, but the functional form would remain the same—
that is, it would still be an inverse square relationship. 

Problem 3 – Effects of Changing Both Charges on Electrical Force 

Step 1. Next, students should move to page 3.1 and read 
the text there. Then they should move to page 3.2, which 
shows two positively charged particles separated by a 
distance r. In this simulation, students can vary the charges 
of both particles (q1 and q2). Students should vary q1 and q2 
and observe the effects on F. Then they should answer 
questions 6–9. 

Q6. If the charges on both particles are doubled, what is the 
effect on the force? 

A. The force increases by a factor of four. 

Q7. What do these data indicate about the relationship between the charges on two particles 
and the electrical force between them? 

A. The data suggest that force is proportional to the product of the charges. Encourage 
students to discuss why this must be the case. 

Q8. Write an equation for electrical force F in terms of q1, q2, and r. Let the constant of 
proportionality be k. 

A. 
2

1 2q q
F = k

r

i

; encourage student discussion on how to derive this equation. 
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Q9. What are the numerical value and units of k? 

A. To solve this problem, students should first solve the equation they derived above for k, 
as shown below: 

2

1 2

F r
k =

q q

i

i

 

Then students should use the simulation on page 3.2 to obtain specific values for F, r, q1, 
and q2 and use these values to calculate the value of k. For example, if r = 2 m, 
q1 = 1 × 10–6 C, and q2 = 1.5 × 10–3 C, then  
F = 3.38 N. Therefore, k = 9 × 109 N·m2/C2, as shown below: 

2

9 2 2

6 3

(3.38 N)(2 m)
k =

(1  10  C)(1.5  10  C)

= 9  10  N m / C

− −× ×

× i

 

Problem 4 – The Effect of the Signs of the Charge on Electrical Force 

Step 1. Next, students should move to page 4.1 and read 
the text there. Then they should examine the simulation on 
page 4.2, which shows two charged particles separated by a 
distance r. In this simulation, q1 is negative. Students should 
vary r by dragging the smaller point and observe the effects 
on F. Then students should vary q1 and observe the effects 
on F. They should then answer questions 10–13. 

 

Q10. How are the electrical force and the force vectors in this simulation different from those on 
pages 1.3, 2.2, and 3.2? 

A. The force in this simulation is negative; it was positive in the other simulations. The force 
vectors in this simulation are pointing toward each other. In the other simulations, the 
force vectors pointed away from each other. 

Q11. Are these particles being attracted or repelled by each other? How is this different from 
the previous simulations? 

A. In this simulation, the particles are attracted to each other. In the other simulations, they 
were repelled by each other.  
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Q12. Use Coulomb's law to determine the charge (q2) on the 
larger particle. 

A. First, solve the Coulomb's law equation for q2, as 
shown below: 

2

2

1

F r
q =

k q

i

i

 

Then substitute specific values to solve for q2. For 
example, if r = 2.8 m, q1 = –5 × 10–6 C, and F = –4.29 
N, then q2 = 7.5 × 10–4 C, as shown below: 

2

2 2

4

9 2 6

( 4.26 N)(2.81 m)
q =

(9 10 N m / C )( 5 10 C)

= 7.5 10 C−

−

−

× − ×

×

i

 

 

Q13. What is always true about the electrical force vector for each particle, regardless of the 
magnitude or sign of the charge on the particles? 

A. The magnitude of the force vector is always the same for both particles. 

Problem 5 – Using a Test Charge 

Step 1. Next, students should read the text on page 5.1 
before moving to page 5.2, which shows a movable test 
charge and two fixed-point charges. The vector attached to 
the test charge indicates the net electrical force on the test 
particle due to q1 and q2. Students should move the test 
charge and observe the electrical force vector. Then they 
should answer questions 14–16. 

 

Q14. Is the charge of the test particle positive or negative? 
Explain your answer. 

A. Charge q2 is positive, and the electrical force vector of 
the test charge points away from particle 2. Like 
charges repel. Therefore, the test charge must also be 
positively charged. 

Q15. At what point is the net force on the test particle equal 
to zero? 

 

A. The net force is zero when the test charge is between the particles and a little closer to 
particle 1. The distance between the test charge and particle 1, r1, is about 3.5 units. 
The distance between the test charge and particle 2, r2, is about 4.5 units. 
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Q16. Use Coulomb's law to determine q1. 

A. At the point where the net force is zero, F1 = F2, where F1 is the force on the test charge 
due to q1 and F2 is the force on the test charge due to q2, as shown below: 

1 test 2 test

2 2

1 2

q q q q
F1 = k F2 = k

r r
      

Setting these equations equal to each other and rearranging gives an equation for q1. 

k
1 testq q

2

1

= k
r

2 testq q
2

2

1 2
2 2

1 2

2
2 1

1 2
2

r

q q
=

r r

q r
q =

r

 

Substituting values from the simulation yields 
2

2

2
2 1

1 2
2

(5 mC)(3.5)
= = 3 mC

(4.5)

q r
q =

r
. 
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Activity Overview: CAS & DCC 
This is a guide to more advanced features of CAS (Computer Algebra System) and DCC (Data 
Collection Console). This is intended as a guided exploration activity to help students become 
more familiar with the capabilities of CAS and DCC. 
 
 
 

Teacher Preparation and Notes: 
• Estimated time for activity: 20 minutes 

• No preparation needed. 

 

Materials: 
• TI-Nspire

TM
 CAS handheld technology 

• Any sensor that connects to the TI-Nspire CAS handheld directly, or a sensor and 
EasyLink adapter 

 
 
 

Part 1 – CAS 

Derive an Equation 

Open a new problem and Calculator page by pressing / c > Insert > Problem > Add 
Calculator. 

Consider the equations for centripetal force. Enter the following and note the result as 
successive steps in a derivation: 

• f:= m × a · 

• a:= v2/r · 

• f · 

• v:= 2πr/t · 

• f · 

• t:= 1/freq · 

• f · 
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Conversions 

Quantity or unit conversions can be done using littoral 
symbol manipulation, or by using the built-in units. 

Enter 20mi/hr × (5280 ft/mi) × (hr/(3600 s)). 

Now press / · to get the approximate (decimal) value 
for the answer. 

Use the underscore to access the built-in units, and use the 
conversion operator (►) to make a direct conversion. 

• 20_mi/_hr ►_ft/_s · 

In the Bejing Olympics, Usain Bolt ran the 100 m in 9.69 s. What is his average speed in m/s? 

What would this be in ft/s? In km/min? In mi/hr? 

10.3 m/s; 33.8 ft/s; 0.62 km/min; 23.1 mi/hr 

Measurements can be converted into base or standard units.  

• 1.2·_atm►_p returns standard units of pressure. 

 

Derivatives and Integrals 

A wide range of features to work with functions can be accessed from a Calculator page 
under the Calculus menu. 

Templates for derivatives or integrals can also be accessed from the Calculator page by 
pressing /r. 

On a Graphs & Geometry page, derivatives can be determined using the Slope tool from the 
Measurement menu; integration can be done (and shown graphically) with the Integral tool, 
also in the Measurement menu. 

A spring has a spring constant of 3000 N/m and an unstretched length of 15 cm. If the string is 
stretched from 20 cm to 25 cm, how much work has been done? 

On a Calculator page:  

• Define the function by typing f:=k·x and then pressing 
·. 

• Define the spring constant k by typing k:=3000_N/_m 
and then pressing ·. 

• Obtain the definite integral template from r, or obtain 
the integral template from Menu > Calculus > Integral. 

• Fill in the template from 20_cm to 25_cm for (f)dx. 

Answer: 33.75_J; Note the units! 
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On a Graphs & Geometry page: 

• Plot the function f1(x) = 3000x. 

• Adjust the window settings to (–0.05, 0.3), 
(–100, 900). 

• Menu > Measurement > Integral 

• Click on the graph, and press .2, ·, .25, ·. The 
integral will be shown numerically and graphically. Grab 
the value and move it to a convenient location. 

• Menu > Actions > Attributes 

• Select the value, arrow right to increase the precision to 
the desired degree, and press ·. 

Answer: 33.75; Units are not given. 

Part 2 – Data Collection Console  

The Data Collection Console and menus allow you to design an experiment with a variety of 
options. When a sensor is connected, the system automatically detects and identifies the 
sensor. You then have a number of decisions to make: 

Display Applications: 

• Data & Statistics 

• Lists & Spreadsheet 

• Graphs & Geometry 

• Meter only 

Data Collection Console: 

• Menus 

• Modes (with setup menus) 

o Time Graph 

o Events with Entry 

o Selected Events 

o Monitor 

Open a new document and connect a sensor to the handheld. Explore and discuss with a 
partner the menus and modes available. 

Wrap Up: 

• This activity is an informational exploration to see and use some of the features of CAS 
and the Data Collection Console. 
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Activity Overview: 
In this investigation you will team up with others in your class and explore the rate at which a 
material cools an object. You may know that it takes a certain amount of energy to change the 
temperature of a given mass. You will discover some important relationships in this 
investigation. 
 
Materials: 

• TI-Nspire
TM

 CAS handheld technology (one per student) 

• TI-Nspire CAS Student or Teacher Edition computer software (one per team) 

• Vernier EasyTemp
TM

 with USB mini-A to standard-A adapter or Go!
TM

 Temp temperature 
sensor (2 per team) 

• Some approved cooling material. This material should be at room temperature and 
should be voluminous enough to contain the complete metal in both temperature probes.

• Container that holds the cooling material 
• TI-Nspire Computer Link with direct-connect cable 

• Calculator file Rates_of_Cooling.tns 

• Paper towels 

• Safety goggles for some cooling materials  
 

 
Part 1 – Data Collection 

1. Once you form a team, discuss what material you want to use as the cooling agent. Be 
realistic and make sure you can obtain enough of the material to fully contain both of your 
temperature probes. 

2. Get your selected material approved by your teacher. 

3. Collect the materials you need and move to a computer, where you will open a new 
document in the TI-Nspire CAS software. Start the document with a Notes page that contains all 
the necessary information (assignment name, the names of individuals on your team, the date, 
and the name of the cooling material you selected). Save this file with an appropriate name in a 
location that you can find later. While this is happening, bring your cooling material to room 
temperature. 

4. Now we want to plug the two temperature probes into the USB ports on the computer. This 
should launch the Data Collection application. If the Data Collection application doesn’t launch, 
use Ctrl-D on the keyboard. Select Data & Statistics to display the data collection. 
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5. You will see one of the temperatures displayed in the Data Collection console at the bottom 
of the page. You want to toggle the display until you see the probe that you will heat. The other 
probe will be in your cooling material. Place one of the probes in your hand and the other in your 
cooling material. Use e to get to the meter display in the middle of the console, and then use 
the £¤ arrow to switch to show the warmer probe. 

   
6. Now switch the focus to the Data & Statistics application by pressing /e, and move to 
the y-axis. Press / b, select Add Y Variable, and select dc01.temp2 for the other probe. 

   
7. Move the legend to the upper-right corner of the page using your cursor. 

 
8. Now warm the selected temperature probe to about 5 degrees above the ambient 
temperature of the cooling material. Note that your body is 37 degrees Celsius. Note: If the 
difference in temperatures is very large, the warm probe will significantly change the 
temperature of your cooling solution when they are placed together, and this will disrupt the 
results of the experiment. 
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9. Switch your focus to the Data Collection console using /e. You might want to adjust the 
data collection parameters at this time. Of particular interest is the time you will collect data. 
Materials cool things at different rates, and this default time setting might be too short or too 
long. Once you are satisfied, e to the play button. 

     
10. To collect the data, place the warm probe in the cooling material and then immediately press 
·. 

11. If your data plot looks good, dismiss the Data Collection application by tabbing to the X and 
pressing ·. If these are not the results you expected, make any adjustments to the data 
collection, warm the one probe, and when ready repeat as before. The difference here will be 
that you will select Discard right after you place the temperature probe in the cooling material. 

   
12. Save your document and send the data to each person in your group. Use the TI-Nspire 
Computer Link software and place it in a folder on the handheld for this class or experiment. 
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Part 2 – Data Analysis 

1. Now we would like to examine the data for some critical points. Insert a Lists & Spreadsheet 
page by pressing c and selecting Lists & Spreadsheet. On the diamond line, press = and 
then use the keypad to select h to see the list of available variables. Select the “time” data for 
Column A. Repeat this process in Column B, this time selecting the “temperature” data for the 
probe that started to warm. You might have to take two tries to get the right set of temperatures. 

   
2. Move to the top of these two columns and name them. Move up and down in each column, 
explore the values, and consider how they change. 

 

3. We want to model the pattern in the plot of temperature vs. time for the warm probe cooling in 
your material. We can use the equation Temperature = Ambient_Temp + (Starting_Temp – 
Ambient_Temp) * Cooling_FactorTime, or y = a + (b*ct). To help identify the values of the 
Ambient_Temp and the Starting_Temp, we can insert a Calculator page. On this page, we can 
collect the mean of the list that has the temperatures of the cooling material and the maximum 
value in the warm probe list. Key in max(, select the variable name of the temperature data of 
the warm probe from the Variables menu (h), and press ·. Then key in min(, select the 
temperature data of the probe in the cooling material from the Variables menu, and press ·. 
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4. Now assign the values to a and b using the := assignment command. Notice that the letters 
will now be bold and a and b will be in the variable list. 

   
5. Return to the Data & Statistics page and try to guess the value of c by using Plot Function 
from the Analyze menu. Graph the equation f1(x) = a + b*cx and use 0.50 as your starting value 
for c. Note: You could use f1(Time) = a + b*cTime, but we already used Time to stand for the list 
of times in the Lists & Spreadsheets application. Move the label out of the way and click on it to 
edit until you get a good fit. 

   
6. To more completely understand what we have here, let’s look at the slope of this plot. Notice 
at the earlier times, we have a steeper slope, while as time goes on, the slope is approaching 
zero. What is the meaning of this slope? What are the units? The complete set of slopes might 
have a pattern. The pattern in the slope data can be determined by looking at the slope of the 
tangent at each point along the data or, more efficiently, by getting the derivative. 

7. Go to a Calculator page and define the function slope(x) as the derivative of the function f1(x) 
we found. From the Calculus menu, select Derivative. Fill in the boxes as shown. 
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8. Test this new function out using a time of 10 seconds. Examine this number and consider 
what it means. 

   
9. To get the slopes for all the times, we can return to the Lists & Spreadsheet page and add a 
third column we can call Slopes. First, move to the diamond line and, starting with =, select 
slope from the variable key, or just key it in and then reference the A[ ] column or time[ ] to get 
the slopes at each time. Move to the top of Column C and name this list. 

   
10. Check out the value in the slopes column for the time of 10 seconds, and explore the 
values in the column. 
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11. These individual slopes occurred at particular times, but they are also associated with how 
far the current temperature was away from the ambient value. This pattern might be more 
revealing. That is, looking at the rate at which the temperature is changing over time as a 
function of how far from the ambient temperature we are, what would you expect the 
temperature change rate to be if you were far from the ambient temperature? If you were close 
to it? We can make a column of these values called tempdiff by using the formula =tempa[ ]–a. 
The value is a variable reference, not a column reference. 

   

12. Notice the first value in this column. Look at the other values in this list as well. 

   
13. To more fully understand the relationship between these lists, we could set up a plot in a 
new Data & Statistics page. Set the x-values to tempdiff and the y-values to slopes. 
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14. What do you see in this plot? What pattern do you see? Add a movable line or do a 
regression to name this pattern. 

   
15. What would it mean if the data had a steeper slope than you have here? What is the slope 
of the function you obtained for the relationship between slopes and tempdiff? Select one point 
on the plot and parse its meaning. 

16. Find the specific heat of your cooling material and see if you can relate this to the function 
you just obtained and the following relationship: 

Temperature = Ambient_Temp + (Starting_Temp – Ambient_Temp) * Cooling_FactorTime 

17. Convert a and b to degrees Fahrenheit, and give the time at which the temperature of your 
probe would reach 120% of the ambient temperature. To do this, introduce a Calculator page 
(c1) and then, using the catalog (k), move to the tmpCnv() command. The syntax is to 
give the value you want to convert (you may use a or the actual value) and then add the units 
_°C, a comma, and then the units _°F, as shown below. You obtain the units from the catalog 
(k) and then select 3 and move to the Temperature line. Expand this area with a right arrow 
(¢). 

   

 
18. Save your document and send the completed document to your teacher. 
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Part 3 – Closure 

1. Get the Rates_of_Cooling.tns file from your teacher and answer the questions either as a 
team or individually.  

2. Send the completed document to your teacher. 

 

Extensions (Optional) 

Find r and k if a + b × ct is really equal to a + (b × rkt), with rkt being r^(k*t).  

Change the time data to minutes and get a new function and plot. Explore how the plot and 
function change. 

Convert a and b to degrees kelvin, and give the modified function and plot for temperature vs. 
time. Determine how your function and plot would change. 

Determine the specific heat of your material, and compare it to the known value or report it if 
you cannot find a published value.  

Graph your function in Graphs & Geometry and get the tangent line. Measure the slope of this 
line and get the coordinates of the point at which the tangent line is drawn. Grab the point and 
move it to a time that is in your data. You may need to just edit the coordinate for x to be an 
integer value. Get the slope value and compare it to the value for that time in your data (in Lists 
& Spreadsheet). 

85



 

©2009 Texas Instruments Incorporated  education.ti.com/activities 

This page was intentionally left blank. 

86



 
Rates of Cooling 
Physics – Teacher Notes 

 

 

©2009 Texas Instruments Incorporated Page 1 education.ti.com/activities 

Activity Overview: Rates of Cooling 
Students are familiar with the CSI shows, where the time of death is determined by measuring 
the liver temperature of the corpse. In this investigation they will explore as a team the cooling 
rate of some material as the temperature moves from being warmer than room temperature to 
being room temperature. This experience should be connected to the concept of specific heat, 
experimental design, and modeling patterns in data.  
 
 

Teacher Preparation and Notes: 
• Estimated time for activity is one class period or less for data collection and then one full 

class period for the analysis and use of the Rates_of_Cooling.tns file. 

• A list of TI-Nspire skills appears on the student worksheet.  

• You will need to demonstrate data collection with the TI-Nspire using the TI-Nspire 
software. It is best to use the Teacher Edition in the SmartView/Emulator mode so 
students can see which keys you press. Using the EasyLink with the two TI temperature 
probes or with the two EasyTemps on the computer requires the USB mini-A to 
standard-A adapter or the Go!Link equipment.  

• You will want to use teams of 2 or 3 as you do this investigation. 

• Avoid toxic materials. 

• Obtain the cooling material in advance so that it can be at room temperature. 

• Students should keep the temperature differential small, not much more than 10 
degrees. They can easily heat the probe with their bodies. 
 

Materials: 
• TI-Nspire

TM
 CAS handheld technology (one per student) 

• TI-Nspire CAS Student or Teacher Edition computer software (one per team) 

• Vernier EasyTemp
TM

 with USB mini-A to standard-A adapter or Go!
TM

Temp temperature 
sensor (2 per team) 

• TI-Nspire CAS Teacher Edition computer software and projector with data collection 
cables for demonstration purposes 

• Various materials to cool in. Teams can select and provide these. You may direct the 
teams to use the materials you provide. These materials should be at room temperature 
and should be voluminous enough to contain the complete metal in both temperature 
probes. It would also be useful to have materials for which the teams can obtain the 
specific heat values.  Some suggested materials are salt, air, water, vinegar, alcohol 
(90% or 70%), gelatin, ketchup, metal powder, and solutions such as saturated sugar 
water. 

• Student worksheet Rates_of_Cooling_Student_Physics.doc 

• Container that holds the cooling material, won’t tilt, and is large enough to hold both 
temperature probes fully without touching (1 per team) 

• Connect-to-Class, TI-Nspire Navigator, TI-Nspire Computer Link with direct-connect 
cable or unit-to-unit cables to send the Rates_of_Cooling.tns file and collect the student 
documents with results  

• Calculator file Rates_of_Cooling.tns 
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• Paper towels 

• Safety goggles for some cooling materials 
 
 

Suggested Related Activities: 
To download any activity listed, go to education.ti.com/exchange and enter the number in 
the quick search box. 

• Cooling Rates — 8546 

• Forensics Case 14—Hot Air, Cold Body: Using Newton's Law of Cooling to Determine 
Time of Death — 6380 

• Chill Out: How Hot Objects Cool — 3988 

• Various Activities at TI Physics: http://www.tiphysics.com/ 

 
Some Skills Your Students Will Need: 

- Create a new document on the TI-Nspire software and save it 
- Save a document, give it a name, and create or find a Folder 
- Open a document on the TI-Nspire 

- Launch the Data Collection application (using two probes) and dismiss it 
- Adjust the settings from the Data Collection application menu 

- Switch the view in the Data Collection console to show the two different temperature 
probes 

- Add a new application to your problem 

- Use various tools in Data & Statistics including Add Movable Line and Regression 
- Plot a function in Data & Statistics 
- Load data into Lists & Spreadsheet  and enter formulas 
- Use the Calculator application to create variables and assign values 
- Start and stop data collection 
- Send and receive files from your TI-Nspire software and your handheld 
- Use units in the Calculator application 
- Convert temperature units using tmpCnv() 
- Use the Derivative function in the Calculator application 
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Part 1 – Data Collection 
 
1. Set up the students at a computer with the TI-Nspire CAS software. They will need two 
temperature probes and the adapters to collect data. 
 
2. Once the teams decide what cooling material they want to use, you will need to approve its 
use. Make sure the material is not toxic to the computers (or the children) and that you/they can 
obtain a large enough quantity so that it will hold both temperature probes fully without touching. 
 
3. Let the material sit in your room long enough so that it reaches room temperature.  
 
4. At the end of this part, after the team has collected the data, they will need to save it again 
and then use the TI-Nspire Computer Link software to send it all the handhelds in the team. You 
may need to demonstrate this. 
 

 
 
 
Part 2 – Data Analysis 
 
1. This section can be done on the handheld. 
 
2. There is some intensive TI-Nspire use in this part. Monitor the teams and see that each 
member is working through the steps. 
 
3. You can periodically check for progress by attaching the student handhelds to Connect-to-
Class and getting the documents. 
 
4. The examination of the pattern in the slope of their plot could be optional. Have the students 
answer the questions either in their groups or in a classroom discussion. What is the meaning of 
this slope? [rate of change in temperature over time] What are the units? [degrees Celsius/sec] 
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The complete set of slopes might have a pattern. The pattern in the slope data can be 
determined by looking at the slope of the tangent at each point along the data or, more 
efficiently, by getting the derivative. 
 
5. Looking at the rate at which the temperature is changing as a function of how far from the 
ambient temperature we are might be useful. What would you expect the temperature change 
rate to be if you were far from the ambient temperature? [a high rate of change] If you were 
close to it? [a low rate of change] 
 
6. If the students use Movable Line, they may need some demonstration of these techniques. 
 
 
Part 3 – Closure 
 
1. Send the students the Rates_of_Cooling.tns file through Connect-to-Class, through the 
Computer Link software, using the unit-to-unit link, or with your TI-Nspire Navigator. 
 
2. You may have the teams answer the questions rather than doing this individually. 
 
3. Collect the answers. 
 
4. Spend time in class going over the questions and answers that are most relevant to your 
class. You may wish to revisit these questions in the assessment for this unit. 
 
 
Extensions (Optional)  
 
Find r and k if a + b × ct is really equal to a + (b × rkt), with rkt being r^(k*t).  
[For a particular time, you can find r^k by setting ct = rkt. If k is the slope of the slope vs. 
temperature difference graph, then you can solve for r.] 
 

Change the time data to minutes and get a new function and plot. Explore how the plot and 
function change. 
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Convert a and b to degrees kelvin, and give the modified function and plot for temperature vs. 
time. Determine how your function and plot would change. 
 

     
 
   

   
 
Determine the specific heat of your material, and compare it to the known value or report it if 
you cannot find a published value.  
 

Graph your function in Graphs &Geometry and get the tangent line. Measure the slope of this 
line and get the coordinates of the point at which the tangent line is drawn. Grab the point and 
move it to a time that is in your data. You may need to just edit the coordinate for x to be an 
integer value. Get the slope value and compare it to the value for that time in your data (in Lists 
& Spreadsheet). 
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Let’s Roll – Ball on a Ramp 
Physics – Student Activity 

Name __________________________ 

Class __________________________ 
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Activity Overview: 
• In this activity you will examine the graphs of position, velocity, and acceleration versus 

time for a ball on a ramp. Following this activity, you will be able to sketch the graph of 
position versus time, velocity versus time, and acceleration versus time for an object 
moving with constant acceleration. You will also be able to interpret important values on 
these graphs. 

 
Materials: 
• TI-Nspire

TM
 CAS handheld 

• CBR 2
TM

 

• Inclined plane at least 1 m long 

• Ball: tennis ball size or larger (carts on a ramp can be used instead of balls) 
 

 

Prior to the Activity Data Collection 

1. Place the motion detector at the top of the ramp, and roll the ball up the ramp from the 
bottom. 

2. Sketch a prediction of what the position versus time graph will look like in the space to the 
right. (Note that the “position” of the ball is the distance of the ball from the motion 
detector.) 

 

 

 

 

3. Watch the velocity of the ball. Predict the velocity of the ball as a function of time. Sketch 
the prediction in the space to the right. 

 

 

 

 

4. Now, think about the acceleration. Sketch a prediction of the acceleration as a function of 
time. 
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Data Collection 

1. Set up a ramp with a small angle. If the ramp is too 
steep, you will not get very much data. You want the 
ball to roll up and down the ramp over a time period of 
at least 4 seconds. 

2. Open a new document on the TI-Nspire and connect 
the CBR 2. Choose Graphs & Geometry as the 
application to collect the data. 

3. Give the ball a gentle roll up the ramp, and press · to begin collecting the data. If the 
data look as you expect them to, disconnect the CBR 2 and close the Data Collection 
console. If not, press · to collect data again. Discard the old data. Repeat until you have 
a smooth set of data. 

4. Save this file on your TI-Nspire and send a copy of the document to the other members of 
your lab group. 

5. Sketch your graph to the right or print a copy using the TI-Nspire Computer Link software. 

6. Press /G to hide the graph entry line, and examine the data. 

7. Select MENU > Trace > Graph Trace. Trace to the 
vertex of the parabola and record the coordinates. x: 
__________ y: ________ 

8. What do the x- and y-coordinates represent in this data 
set? 

 

9. Recall the vertex form of a quadratic equation from your algebra class. What is that 
equation? 

 

10. Use this equation and substitute in the coordinates of the vertex for this data. You do not 
yet know a value for A. 

 

11. Press /G to bring the graph entry line back on the screen. Select MENU > Graph 
Type > Function to bring up the function line. 

12. Enter the function. Begin with an initial value of A = 1. 

13. Grab the outer edges of the parabola and fit the equation to the data set. Record the final 
equation. 
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14. Press c and insert a Data & Statistics page. Set up a 
plot of velocity as a function of time. How does this plot 
match your prediction? 

15.  Select MENU > Analyze > Add Movable Line. 

16. Grab the line and adjust it so that it fits the data. 

17. Record the equation for the line. 

18. Explain what the slope of the equation represents and what it means if the velocity versus 
time plot is linear. 

19. How does the slope compare with the A value found for the position versus time plot? 

20. Why is the y-intercept negative? What does the y-intercept of the velocity versus time plot 
represent? 

21. Press c and select Calculator. 

22. Expand your equation for f1(x) from the parabola that 
was in vertex form. An example is shown to the right. 
Enter your equation from 13 above. (A sample is shown 
to the right.) 

23. Identify the acceleration, initial velocity, and initial 
position from this equation. 

24. Add another Data & Statistics page. Turn on a plot of acceleration versus time. How does 
this compare with your prediction? 

25. Describe how the equations for the position, velocity, and acceleration will change if the 
angle of the ramp is increased. 
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Activity Overview: Let’s Roll – Ball on a Ramp 
Students will collect data for a ball rolling up and back down a ramp. They will analyze the 
position, velocity, and acceleration versus time plots. Following this activity, students will be able 
to sketch the graph of position versus time, velocity versus time, and acceleration versus time 
for an object moving with constant acceleration. Students will also be able to interpret important 
values on these graphs. 
 
 
 
 

Teacher Preparation and Notes: 
• Estimated time for activity: 50 minutes (predictions can be done ahead of time to provide 

more time for the lab during class) 

• Students should have knowledge of linear and quadratic equations. Knowledge of 
quadratics includes both vertex and standard forms of quadratic equations. 

• This is a student-centered lab, with students organized in lab groups with a maximum of 
4 students per group. 

• Students may need to practice rolling the ball. They should keep the ramp at a small 
angle and may want to begin collecting the data just after they release the ball. 

 
Materials: 

• TI-Nspire
TM

 handheld technology 

• TI-Nspire CAS handheld technology   

• CBR 2
TM

 

• Inclined plane at least 1 m long 

• Ball: tennis ball size or larger (carts on ramps can be used instead of balls) 

• TI-Nspire Computer Link software can be used to print copies of the graphs 

• Student worksheet Let’s_Roll_Student_Physics.doc 
 
 
 
 

Suggested Related Activities (optional): 
To download any activity listed, go to tiphysics.com/activities  

• Rolling a Ball on an Inclined Plane — 8550 
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Prior to the Activity Data Collection 

Questions 2–4 involve making predictions. These are provided to engage students and get 
them thinking about what the data should look like. Research indicates that student 
conceptual understanding is enhanced when students make predictions prior to collecting 
data. Students should discuss their predictions with their group members, and you may want 
to show some predictions prior to the data collection. 

Data Collection 

1. Set up a ramp with a small angle. If the ramp is 
too steep, you will not get very much data. You 
want the ball to roll up and down the ramp over a 
time period of at least 4 seconds. 

2. Open a new document on the TI-Nspire and 
connect the CBR 2. Choose Graphs & Geometry 
as the application to collect the data. 

3. Give the ball a gentle roll, and press · to begin 
collecting the data. If the data look as you expect 
them to, disconnect the CBR 2 and close the Data 
Collection console. If not, press · to collect data 
again. Discard the old data. Repeat until you have 
a smooth set of data. 

4. Save this file on your TI-Nspire and send a copy of 
the document to the other members of your lab 
group. See sample data to the right. 

 

5. Sketch your graph to the right or print a copy using 
the TI-Nspire Computer Link software. 

6. Press /G to hide the graph entry line, and 
examine the data. 

7. Select MENU > Trace > Graph Trace. Trace to 
the vertex of the parabola and record the 
coordinates. Answer using sample data: x: 1.9; 
y: 0.283 

8. What do the x- and y-coordinates represent in this data set? The x-coordinate 
represents time, and the y-coordinate represents distance from the CBR 2. 

9. Recall the vertex form of a quadratic equation from your algebra class. What is that 
equation? 

2( )y A x h k= − + , where the coordinate of the vertex is (h, k) 
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10. Use this equation and substitute in the coordinates 
of the vertex for this data. You do not yet know a 
value for A. 

2( 1.9) 0.283y A x= − +  

11. Press /G to bring the graph entry line back on 
the screen. Select MENU > Graph Type > 
Function to bring up the function line. 

12. Enter the function. Begin with an initial value of 
A = 1. 

13. Grab the outer edges of the parabola and fit the 
equation to the data set. Record the final equation.

20.095( 1.9) 0.28y x= − +  

14. Press c and insert a Data & Statistics page. Set 
up a plot of velocity as a function of time. How 
does this plot match your prediction? 

15. Select MENU > Analyze > Add Movable Line. 

16. Grab the line and adjust it so that it fits the data. 

17. Record the equation for the line. See equation 
and graph to the right.   

18. Explain what the slope of the equation represents 
and what it means if the velocity versus time plot 
is linear. The slope represents the acceleration. 
A linear graph for velocity versus time 
indicates that the acceleration is constant. 
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19. How does the slope compare with the A value found for the position versus time plot? The 
slope is approximately twice the value of A. 

20. Why is the y-intercept negative? What does the y-intercept of the velocity versus time plot 
represent? The y-intercept represents the initial velocity. It is negative because 
when the ball began rolling, it was approaching the motion detector. 

21. Insert a Calculator page by pressing c and 
selecting Calculator. 

22. Expand your equation from the parabola that was 
in vertex form. An example is shown to the right. 
Enter your equation from 13 above. 

23. Identify the acceleration, initial velocity, and initial 
position from this equation. The acceleration is 
twice the value of 0.95 m/s2. The initial velocity 
is –3.61 m/s, and the initial position is 0.62. 

24. Add another Data & Statistics page from the c 
screen. Turn on a plot of acceleration versus time. 
How does this compare with your prediction? The 
plot should be horizontal, with a y-value 
approximately equal to the slope of the 
equation for the velocity versus time. 

25. Describe how the equations for the position, velocity, and acceleration will change if the 
angle of the ramp is increased. The acceleration will increase. This means that the 
coefficient in front of x2, the slope of the velocity versus time plot, and the y-value 
of the horizontal line on the acceleration versus time graph will all increase. The 
maximum value for the acceleration is 9.8 m/s2. (This is the case when the ball is in 
free fall.) 
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Activity Overview: Projectile Motion 
Students explore projectile motion. They will learn how the initial velocity and angle of launch 
affect the trajectory of a projectile. In Problem 2, they will examine the horizontal and vertical 
velocity vectors for the projectile and discover the acceleration is due to gravity in the vertical 
direction. In Problem 3, they will determine how angle affects the range of the projectile. 
 
 
 
 

Teacher Preparation and Notes: 
• Estimated time for activity: 45 minutes 

• Load the TNS file Projectile_Motion_Physics.tns onto all student handhelds. 

• Students should know about the basics of motion with constant velocity and constant 
acceleration. 

• Students may work in small groups or individually depending upon the teacher’s 
preference. 

• There are no handouts for this activity. The students answer on the TI-Nspire. 

• A sample TNS file with answers and data is included in your materials. 

 
Materials: 

• TI-Nspire™ handheld technology 

• TI-Nspire™ CAS handheld technology 

• If needed, TI-Nspire™ computer software 

• Projectile_Motion_Physics.tns 

• Projectile_Motion_Answers_Data_Physics.tns 
 
 
 
 

Suggested Related Activities (optional): 
To download any activity listed, go to ti.physics.com/activities.  

• Two-Dimensional Motion and Vectors — 8876 
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Physics – Student Activity 
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Activity Overview: 
A block at rest on an incline has several forces acting on it. How do these forces change and 
what factors influence these forces? You will investigate pairs of opposing forces that make a 
situation static, resolve force vectors, and see how forces on an incline depend on some 
factors. At the end of this activity, you will calculate the forces acting on a block on a given 
ramp. 
 
Materials: 
• TI-Nspire

TM
 CAS handheld 

• Forces_on_an_Incline_Physics.tns 
 

 

Problem 1 

Open the Forces_on_an_Incline_Physics.tns file on your 
TI-Nspire handheld. Follow your teacher’s instructions to save 
this file. 

Work through the directions on the pages of the .tns file. 

On page 1.3, you can interact with the objects on the screen. 
Drag the ends of the weight, wt, and Pull vectors, and notice 
what happens to other forces in order to maintain a static 
situation. 

Answer the questions on pages 1.4–1.7 based on your 
observations and explorations on the diagram. 

Problem 2 

In Problem 1, all forces are vertical or horizontal. On an incline, 
forces are not all perpendicular to each other. In order to 
understand what is going on, we need to resolve force vectors 
into perpendicular components. On an incline, it is easiest to 
resolve the weight vector into components perpendicular and 
parallel to the incline. This is done with basic trigonometry. 

Study the diagram on page 2.2. The components of the weight 
vector form a right triangle, with wt as the hypotenuse. What 
trigonometric ratios relate the perpendicular and parallel 
components to the weight? Rewrite these in equation form to 
solve for each component. 
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Problem 3 

In Problem 3, you will manipulate the diagram and observe how 
forces in the system change. You can change the weight of the 
block by dragging the end of the wt vector; you can change the 
slope of the incline by dragging point A. Experiment with the 
system and make observations to allow you to answer the 
questions that appear on the following pages on the handheld 
screen. 

You will also capture data as you make changes. In Problem 3, 
capture data by changing the wt only. You must drag the 
weight vector to change the weight of the block. The angle will 
be changed in problem 4. To capture data, press / and then 
^ (the decimal point). Adjust the weight to a different value 
and then press / and ^ again. 

The captured data will appear in the spreadsheet on page 3.4. 
Study the spreadsheet to see how the normal (fn) and friction 
(ff) forces changed as the weight was changed. 

Calculate the perpendicular and parallel components of the weight by entering the formula for 
finding these components in the formula cells of Columns C and E. Start the formula with “=” 
and select the variables by pressing h and choosing the appropriate variable. (Hint: When 
selecting the variable for weight, make sure to select the variable “weight” and not “wt.” Insert 
the ° symbol from the symbol template by using /k.) 

Problem 4 

Problem 4 is a repeat of the same process as Problem 3, except that you will now change the 
angle of the slope, keeping the weight constant. Again, capture data over a range of angle 
values, study the spreadsheet, and calculate the perpendicular and parallel components. 

Problem 5 

Page 5.1 contains a diagram of a block on a ramp. The weight 
and slope angle are given. Draw vectors for all the forces and 
components that relate to the situation. Estimate lengths. To 
access the Vector tool, select MENU > Points & Lines > 
Vector. To make the component vectors dashed lines, select 
MENU > Actions > Attributes. Select the vector, and then 
arrow down to “Line style is continuous” and press the right 
arrow to the command that says “Line style is dotted.” Press 
d when finished. 

After you have added to the diagram, proceed to the next page and then insert a new Calculator 
page by pressing c and selecting Calculator. Use the values given to calculate the actual 
values of all the forces in the system. Your teacher may have special instructions for saving this 
file. Please follow the teacher’s directions. 
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Activity Overview: Forces on an Incline 
In this activity, students will explore the forces in static situations. They first look at vertical and 
horizontal forces with a hanging ball and a block on a table. They then see how to resolve a 
force into perpendicular and parallel components, and they explore how these components 
relate to the forces on a block on an incline. They end the activity by drawing the force vectors 
on a block on an incline and by calculating the values of the forces based on given information. 
 
 
 

Teacher Preparation and Notes: 
• Estimated time for activity: 30–40 minutes 
• This activity requires that students have Forces_on_an_Incline_Physics.tns file on their 

TI-Nspire handhelds. 
• Students need little preparation for this activity. It can be used as an exploratory learning 

activity. 
• Students may work individually, or in pairs with one handheld. 

 
Materials: 

• TI-NspireTM handheld technology 
• TI-Nspire CAS handheld technology 
• Forces_on_an_Incline_Physics.tns 

 
 
 

Suggested Related Activities (optional): 
To download any activity listed, go to tiphysics.com/activities and find the activity in the list. 
• Friction and Inclined Planes — 12876  
• Forces on an Inclined Plane — 12875  
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Problem 1  

Open the Forces_on_an_incline_Physics.tns file on your TI-Nspire handheld. Follow your 
teacher’s instructions to save this file. 

Teacher Tip: It is a good idea to have students immediately save their file under a different 
name (such as “Incline_name” in this case) so that they will have an unblemished original on 
their handhelds in case of difficulty. Also, you may wish to have students “hand this in” 
electronically, and you would find it useful to have the students’ names attached to the file. 

Work through the directions on the pages of the TNS file. 

On page 1.3, you can interact with the objects on the screen. 
Drag the ends of the weight, wt, and Pull vectors and notice 
what happens to other forces in order to maintain a static 
situation. 

Answer the questions on pages 1.4–1.7 based on your 
observations and explorations on the diagram.  

Answers: 

1.4: If the ball is heavier, there must be more tension in the string. 

1.5: If the ball was heavier than the maximum tension of the string, the string would break and 
the ball would fall. This would no longer be a static situation. 

1.6: If the pull was decreased, the value of friction would decrease. Friction provides the 
equilibrium force—up to the maximum value that friction can have in that situation. 

1.7: If you pull harder than friction can oppose, there is a net force and the block will accelerate. 
The maximum amount of force that friction can apply depends on the coefficient of friction and 
the normal force. (This can be explored in another activity.) 

Problem 2 

In Problem 1, all forces are vertical or horizontal. On an incline, forces are not all perpendicular 
to each other. In order to understand what is going on, we need to resolve force vectors into 
perpendicular components. On an incline, it is easiest to resolve the weight vector into 
components perpendicular and parallel to the incline. This is done with basic trigonometry. 

Study the diagram on page 2.2. The components of the 
weight vector form a right triangle, with wt as the hypotenuse. 
What trigonometric ratios relate the perpendicular and 
parallel components to the weight? Rewrite these in equation 
form to solve for each component. 
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Teacher Tip: Students may have this skill already and can skip through this section. If not, a 
discussion of “SOA CAH TOA” in this context may be useful. 

Answers: 

Parallel component = wt × sin(θ) 

Perpendicular component = wt × cos(θ) 

Problem 3 

In Problem 3, you will manipulate the diagram and observe 
how forces in the system change. You can change the weight 
of the block by dragging the end of the wt vector; you can 
change the slope of the incline by dragging point A. 
Experiment with the system and make observations to allow 
you to answer the questions that appear on the following 
pages on the handheld screen. 

 

You will also capture data as you make changes. In problem 3, capture data by changing the wt 
only. The angle will be changed in problem 4. To capture data, press / and then ^ (the 
decimal point). Adjust the weight to a different value, and then press / ^ again. 

The captured data will appear in the spreadsheet on page 3.4. Study the spreadsheet to see 
how the normal (fn) and friction (ff) forces changed as the weight was changed. 

Answers: 

3.5: As the weight of the block changes, the normal force changes proportionately, since the 
ramp must exert more or less force to support the weight of the block. 

3.6: Friction also changes proportionately to the change in weight because the system is static. 

Calculate the perpendicular and parallel components of the 
weight by entering the formula for finding these components 
in the formula cells of Columns C and E. Start the formula 
with “=”, and then select the variables by pressing h and 
choosing the appropriate variable. (Hint: Select variables with 
the variable key h; insert the ° symbol from the symbol 
template by pressing /k.) 

 

Teacher Tip: The variables available are of two types: defined values (012) from the diagram 
on page 3.2 and list variables (…) from the spreadsheet. In the spreadsheet formula, you must 
use (…)weight to calculate with each value in Column A. 

This software has a default of radians for angle measure. You can change the document setting 
(c, System Info, Document Settings) or, more simply, just insert the ° symbol. 

Answers: 

3.8: Pairs of equal and opposite forces are the perpendicular components of weight and normal 
force, and the parallel components of weight and friction. 
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Problem 4 

Problem 4 is a repeat of the same process as problem 3, except that you will now change the 
angle of the slope, keeping the weight constant. 

Again, capture data over a range of angle values, study the spreadsheet, and calculate the 
perpendicular and parallel components. 

Teacher Tip: Stress that problem 3 involved changing the weight, whereas problem 4 involves 
changing only the slope angle. 

Answers: 

4.5: Changing the slope angle does affect the pairs of opposite forces because the components 
of weight change with the angle. 

4.6: Changing the angle has a bigger effect on forces than changing the weight. When 
horizontal, friction becomes 0; when vertical, normal force becomes 0. 

Problem 5 

Page 5.1 contains a diagram of a block on a ramp. The 
weight and slope angle are given. Draw vectors for all the 
forces and components that relate to the situation. Estimate 
lengths. To access the Vector tool, select MENU > Points & 
Lines > Vector. To make the component vectors dashed 
lines, select MENU > Actions > Attributes. Select the 
vector, and then arrow down to “Line style is continuous” and 
press the right arrow to the command that says “Line style is 
dotted.” Press d when finished. 

 

After you have added to the diagram, proceed to the next page and then insert a new Calculator 
page by selecting HOME > Calculator. Use the values given to calculate the actual values of all 
the forces in the system. Your teacher may have special instructions for saving this file. Please 
follow the teacher’s directions. 

Teacher Tip: This problem tests the understanding of all the other parts of the activity. Note 
that the slope is in the other direction. Students should have five vectors in total when 
completed. 

When calculating the forces on the Calculator page of the TI-Nspire CAS, an exact value in 
terms of radians will be given, even with the degree symbol. To get the approximate numeric 
value, press /·. 

Answers: 

Weight = 15 N 

Normal = wt perpendicular = wt × cos(θ) = 13.24 N 

Friction = wt parallel = wt × sin(θ) = 7.04 N 

Teacher Tip: You may want students to save this file as “Incline_name” and submit it for 
marking electronically through Connect-to-Class or Computer Link. 
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Activity Overview: 
In is activity you will explore the frictional force acting on a block and determine what that frictional force 
depends upon. 
 
Materials: 
• TI-Nspire

TM
 CAS handheld 

• Vernier
TM

 EasyLink 

• Vernier Dual Force Sensor 

• Block with a hook 

• String 

• Set of masses 

• Balance 
 

 

Preliminary Questions: 

1. Describe the force needed to move a heavy box across the floor from the time the box is at 
rest and after it is moving. 

 

 

2. Sketch a prediction of the graph of force as a function of time. 

 

 

Procedure: 

1. Open a new document on your TI-Nspire handheld. 

2. Set the force probe switch to ± 10 and plug the force 
probe into an EasyLink. Connect the EasyLink to the USB 
port of the TI-Nspire. Choose to add a Data & Statistics 
page.  

3. If the force probe does not read a force of zero, lay the 
force probe on the table so that no force is acting on it 
and press the b key. To access the zero function, 
choose Menu > Sensors > Zero. The force values should 
now read close to zero. 
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4. Record the mass of your block. ____________________ 

5. Connect the string on the block to the hook on the force 
sensor. You will begin with no additional mass on the 
block and then add mass to the top of the block for each 
additional trial.   

Wooden block

Pull

Mass

  D
u

al-R
an

g
e

F
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rce
 S

e
n

s
o

r

 
You will pull the block by pulling on the force probe. Be sure that the string is horizontal the 
entire time. You should gradually increase the force until the block moves and then try to 
keep it moving at a constant speed. Click the Play button to begin collecting data. Then, pull 
the block. 

6. If the graph is what you expect, use the e key to close out the Data Collection console 
(box). If not, collect the data again and discard the first set of data. 

7. Sketch the graph or print a copy for your lab report. 

Analysis: 

8. Locate the maximum static frictional force and record that value in the data table. (Move the 
cursor to that point and press the x key.) 

9. Select MENU > Analyze > Add Moveable Line. 

10. Adjust the line to go through the horizontal section of the graph, and record the horizontal 
value as the tension in the string. 

11. Now you will add a weight to the top of the block and repeat the process at least five more 
times. For the each trial, have a different person collect the data on his or her TI-Nspire. 
Rotate the person collecting the data each time a different mass is added to the block. 
Record all values in the table. 

Data and Analysis (complete at least six trials): 

Trial Mass (kg) 
Weight 

(N) 
Normal 

(N) 
Maximum 

Friction (N) 
Tension 

(N) 

Kinetic  
Friction 

(N) 

1       

2       

3       

4       

5       

6       
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1. Draw a free-body diagram for the block. Show how you used it to determine the values of 
the normal force and kinetic friction force. 

 

2. Add a Lists & Spreadsheet page to your document. Name columns for normal, maximum 
friction, and kinetic friction. Enter the names in the top cell of each column. Enter the data 
from your table into the spreadsheet. 

 

3. Add a Data & Statistics page and plot maximum friction as a function of the normal. What 
kind of relationship exists? Find the equation. 

 

4. Add another Data & Statistics page and graph kinetic friction as a function of the normal. 
What kind of relationship exists? Find the equation. 

 

5. What do you notice about the equations for Questions 3 and 4? 

 

6. What factors do you think affect the slopes of the lines? 

 

7. The slope of the line is called the coefficient of friction and has the symbol μs  for static 
friction, which is your maximum frictional force, and μk  for kinetic friction. Write an equation 
for the kinetic friction (fk) as a function of the normal (N). 

 

8. The static friction is written as an inequality rather than as an equation. Explain why and 
write the inequality for static friction (fs) as a function of the normal (N). 

 

9. Describe how the data would change if you dragged the block over a rough surface like 
sandpaper. What would happen to the coefficients of friction? 

 

10. In this activity, you plotted friction as a function of the normal force instead of the weight, but 
the weight and normal are the same. Under what conditions is the normal not equal to the 
weight? Why do you think the friction is related to the normal instead of to the weight? 

 

11. What factors affect the frictional force on an object? 
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Activity Overview: Friction 
In this activity, students use a force probe to pull a block across a table. The probe measures 
the tension in the string attached to the block. Students will pull with increasing force until the 
block begins to move and then will pull so that the block moves at a constant speed. They will 
analyze a graph of force versus time to find the maximum static frictional force and the force of 
kinetic friction. They will then add mass to the top of the block and repeat the experiment with at 
least five additional masses. They will record the maximum frictional force and force of kinetic 
friction for each trial in a data table. Students will create graphs of maximum static friction as a 
function of the normal and kinetic friction as a function of the normal. They will obtain these 
values by analyzing graphs of data. 
 
 
 
 

Teacher Preparation and Notes: 
• Estimated time for activity is 50 minutes. Preliminary questions can be done ahead of 

time to give more time on the lab day. 

• Students should be able to draw free-body diagrams and should understand equilibrium. 

• Students should be working in lab groups with a maximum of 4 students per group. 

• If computers are available, students can use the Computer Link software to print graphs 
for their lab reports. 

 
Materials: 

• TI-Nspire
TM

 handheld technology or TI-Nspire CAS handheld technology 

• Vernier
TM

 EasyLink
TM

 

• Vernier Dual Range Force Sensor 

• Block with a hook 

• String 

• Set of masses up to 500 g 

• Balance 

• If available, TI-Nspire Computer Link software 

• Student worksheet Friction_Student_Physics.doc 
 
 
 
 

Suggested Related Activities (optional): 
To download any activity listed, go to tiphysics.com/activities and find the activity in the list. 

• Friction and Inclined Planes 

• Friction: Your Friend or Your Enemy? 
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Preliminary Questions: 

1. Describe the force needed to move a heavy box across the floor from the time the box is 
at rest and after it is moving. 

Answers will vary here. The idea is to get students thinking about what prior 
knowledge they have about friction. Hopefully, they will discuss the fact that it takes 
more force to get the box moving and that the force required to keep the box 
moving is smaller. 

2. Sketch a prediction of the graph of force as a function of time. 

This is a prediction only. It should not be graded as being correct or incorrect. 
Making predictions prior to conducting the experiment increases a student’s 
understanding of the concepts. 

You may want to have students share their predictions and discuss them prior to conducting 
the lab. This will help students get good data by knowing what the graph should look like. 

Procedure: 

1. Be sure that students zero the probe, as instructed on the student handout. 

2. Remind students that they must pull on the probe so that the string is horizontal. Students 
often pull at an angle without realizing it. Pulling at an angle causes the tension to be 
greater than the frictional force rather than equal to it. 

3. Having computers available allows students to print a copy of at least one graph of friction 
as a function of time for their lab report. 

Answers supplied use sample data: 

4. Record the mass of your block. M = 0.2515 kg 

5. See the sample data graph. 

Analysis: 

8. Locate the maximum static frictional force and record 
that value in the data table. (Move the cursor to that 
point and press the x key.) 

9. Select MENU > Analyze > Add Moveable Line. 

10. Adjust the line to go through the horizontal section of 
the graph, and record the horizontal value as the 
tension in the string. 
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11. Now you will add a weight to the top of the block and 
repeat the process at least five more times. 

For the each trial, have a different person collect the 
data on his or her TI-Nspire. Rotate the person 
collecting the data each time a different mass is added 
to the block. Record all values in the table. 

Data and Analysis: 

See the data table for the TI-Nspire to the right. 

1. Free-body diagram: 

 
2. See spreadsheet to the right. 

3. See the plot of maximum frictional force versus normal 
force with the linear regression. 

T f 

   mg   

N 
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4. See the plot of kinetic frictional force versus normal 
force with the linear regression. 

5. Both are linear. The slope of the maximum static 
frictional force is greater than the slope of the kinetic 
frictional force. 

6. The slope is affected by the surfaces between the block 
and the table. 

7. k kf Nμ=  

8. s sf Nμ≤  because the static frictional force can be less than the maximum frictional force. 

9. The slope would increase, as the surface is rougher.  

10. The normal is less than the weight of the block when the block is on an incline or when it 
is accelerating upwards. The frictional force depends on how much weight is exerted on a 
surface (or, in other words, how much the surface pushes on the object). This is why the 
frictional force depends on the normal force and not the weight of the object. 

11. Friction is affected by the normal and the surfaces between the surfaces. 
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